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If this guide is distributed with software that includes an end user agreement, this guide, as well as the software described in it, is furnished under 
license and may be used or copied only in accordance with the terms of such license. Except as permitted by any such license, no part of this guide 
may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, with-
out the prior written permission of Adobe Systems Incorporated. Please note that the content in this guide is protected under copyright law even 
if it is not distributed with software that includes an end user license agreement. 

The content of this guide is furnished for informational use only, is subject to change without notice, and should not be construed as a  
commitment by Adobe Systems Incorporated. Adobe Systems Incorporated assumes no responsibility or liability for any errors or inaccuracies that 
may appear in the informational content contained in this guide. Please remember that existing artwork or images that you may want to include in 
your project may be protected under copyright law. The unauthorized incorporation of such material into your new work could be a violation of 
the rights of the copyright owner. Please be sure to obtain any permission required from the copyright owner. Any references to company names in 
sample templates are for demonstration purposes only and are not intended to refer to any actual organization.

Adobe, the Adobe logo, Acrobat, Acrobat Reader, Illustrator, InDesign, Photoshop, PostScript, PostScript 3 are either registered trademarks or 
trademarks of Adobe Systems Incorporated in the United States and/or other countries.

All other trademarks are the property of their respective owners.

Notice to U.S. Government End Users. The Software and Documentation are “Commercial Items,” as that term is defined at 48 C.F.R. §2.101, con-
sisting of “Commercial Computer Software” and “Commercial Computer Software Documentation,” as such terms are used in 48 C.F.R. §12.212 
or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applicable, the Commer-
cial Computer Software and Commercial Computer Software Documentation are being licensed to U.S. Government end users (a) only as Com-
mercial Items and (b) with only those rights as are granted to all other end users pursuant to the terms and conditions herein. Unpublished-rights 
reserved under the copyright laws of the United States. Adobe Systems Incorporated, 345 Park Avenue, San Jose, CA 95110-2704, USA. For U.S. 
Government End Users, Adobe agrees to comply with all applicable equal opportunity laws including, if appropriate, the provisions of Executive 
Order 11246, as amended, Section 402 of the Vietnam Era Veterans Readjustment Assistance Act of 1974 (38 USC 4212), and Section 503 of the 
Rehabilitation Act of 1973, as amended, and the regulations at 41 CFR Parts 60-1 through 60-60, 60-250, and 60-741. The affirmative action clause 
and regulations contained in the preceding sentence shall be incorporated by reference.
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Achieving Reliable Print Output with 

 

Transparency, Revision 2

 

A practical troubleshooting guide for prepress service providers and other graphic arts professionals who work with 
the new transparency features of Adobe® products.

 

Purpose of this guide

 

This reference and troubleshooting guide gives you, a prepress service provider, the information you need to obtain 
consistent, high-quality output from files that contain objects created with the new transparency features in Adobe

 

®

 

 
professional publishing products. The information provided by this guide may also be of interest to design profes-
sionals, customer support specialists, and OEMs who may require a deeper understanding of transparency in the 
print production process.

This guide explains how transparency is processed (“flattened”) when documents are exported or printed, and it 
explains how flattening affects your workflow. It also tells you what controls Adobe applications provide for 
flattening transparency. It doesn’t explain the ways transparency may be used by a designer to achieve distinctive 
creative effects, nor how each application provides controls for design purposes. The user guide and on-line help for 
each specific application should be consulted for tips on how to design using transparency.

This guide has three sections:

 

Section 1: General Guidelines for Reliable Output 

 

Basic steps and information you should know when working 
with or processing files with transparency from Adobe professional publishing products.

 

Section 2: Controlling Flattener Settings & Results

 

How to use the controls in Adobe professional publishing 
products for managing transparency and flattening.

 

Section 3: Troubleshooting transparency

 

In-depth how-to information about specific print output issues you might 
encounter in jobs that have transparent content. This section also includes RIP specific information and a table of 
file formats as related to their transparency capabilities.
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Products covered in this guide

 

The second revision of this guide covers the following professional publishing products:

 

•

 

Adobe Illustrator 10.x

 

•

 

Adobe InDesign 2.x

 

•

 

Acrobat 5.x

 

•

 

Adobe Extreme 3

 

1

 

•

 

Adobe Level 3 RIPs with direct PDF printing support (release 3015+)

 

2

 

Adobe will revise this document as more of its products are enhanced to support transparency workflows. Check 
www.adobe.com for software updates and up-to-dated versions of this document.

 

Note: 

 

Periodically, Adobe makes product updates available on its Web site at www.adobe.com. Adobe recommends that 
you check the Web site to ensure that you have the most current versions of Adobe products.

 

1. Extreme 3 is a high-end printing component integrated into systems sold and supported by Adobe OEMs.

2. Level 3 RIPs are licensed by Adobe and integrated into systems sold and supported by Adobe OEMs.
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Section 1:General Guidelines for 

 

Reliable Output

 

Section overview

 

This section describes the basics of the new transparency model, how it can affect your work, and the general 
guidelines to follow for achieving reliable, quality output.

 

New transparency options present new prepress challenges

 

The need to handle transparency and transparency-based effects (such as drop shadows) for images, text, and line 
art is standard practice in high-end prepress environments. In fact, you are already quite familiar with handling 
transparency in Adobe Photoshop

 

®

 

 files. 

Adobe has implemented a new transparency model that allows graphic designers to apply transparency and trans-
parency-based effects to all objects in a file, including text, vectors, gradients, and imported graphics. Support for 
creating, proofing, and printing using transparency is provided by all the applications listed under “Products covered 
in this guide” on page 2.

The new transparency model allows users to optimize certain existing workflow practices. For instance, you probably 
use Photoshop to add drop shadows to type and vignettes to images. With a transparency-aware tool such as Adobe 
Illustrator 10.x or Adobe InDesign 2.x, you can apply transparency effects like these directly to the affected objects. 
In addition, these effects remain “live” so that when type is edited, for example, the applied drop shadow changes 
with it. It is not necessary to return to Photoshop to make simple changes like these nor to manage the results as a 
separate raster file. 

Like any new technology, however, the upgraded transparency capability also exposes different and sometimes 
unfamiliar results across applications and file formats. You may already be receiving jobs with transparent design 
elements that you must output to match your customer’s expectations. 

Much can be learned about Adobe’s new approach to transparency and how it in some cases changes existing 
workflow practices. Feedback from customers like yourself indicate that most output problems can be avoided by 
reviewing the information provided in this guide and making a few small changes to your workflow. The degree to 
which you may need to study this guide and deepen your understanding of transparency depends on a number of 
factors, including the following: 

 

•

 

The complexity of the jobs you receive.

 

•

 

The prepress tools you use.

 

•

 

The workflow techniques you employ.

 

•

 

The kinds of devices for which you prepare output.

The rest of this section gives you information to understand the basic issues around transparency, address many 
common problems, and process most jobs successfully. Section 2 goes into greater detail about transparency settings 
and handling transparency in specific workflow scenarios. Section 3 provides troubleshooting resources.
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How transparency changes your workflow

 

Adobe’s new transparency capabilities may affect your prepress workflow as follows:

 

1

 

Files you typically receive could now contain content to which transparency has been applied. These files may 
include the following:

 

•

 

Native files from Illustrator 10.x or InDesign 2.x.

 

•

 

Adobe PDF or EPS files that were created with Illustrator 10.x or InDesign 2.x.

 

•

 

Page layout files that contain links to artwork exported as PDF or EPS from Illustrator 10.x or InDesign 2.x
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.

 

2

 

The transparent design elements in these files may not have been optimally prepared (flattened) for printing 
or separations. Flattening is a necessary step that converts all transparent design elements into a format that 
PostScript devices can print. It should be done as late in the process as possible—preferably by you, the prepress 
service provider.
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Your ability to inspect and adjust for inadequate flattening depends on the format of the files you receive:

 

•

 

Native files from Illustrator 10.x and InDesign 2.x 

 

can be inspected in the application that created them, and the 
application lets you adjust the flattening settings for optimal output and print these files directly.

 

•

 

PDF 1.4 files that were created with Illustrator 10.x or InDesign 2.x

 

 can have live (unflattened) transparency and 
must be flattened like native files by opening them in Illustrator 10.x or by placing them in an InDesign 2.x spread.

 

•

 

EPS and PDF 1.3 files that were saved from Illustrator 10.x with the “Preserve Illustrator Editing Capabilities” 
option selected

 

 (in the EPS or Adobe PDF Format Options dialog boxes) can be opened in Illustrator 10.x to edit 
live transparency and inspect and change the flattener settings. These same files placed into InDesign are 
considered flattened. See the file format section at the end of Section 3 for more details.

 

•

 

Other formats

 

 are flattened into a final form and transparency print results may vary on high-end equipment. 
Although you can’t inspect or adjust the flattening settings for these files, you can resave them with more appro-
priate settings if you have the original native files. Formats that fall into this category include PostScript, Illustrator 
8 EPS (or earlier), InDesign EPS, DCS, PDF 1.2 and 1.3, GIF, JPEG, BMP, and non-Photoshop 6.0 TIFF.

 

Note: 

 

When you save a file as PDF in Illustrator 10, PDF 1.3 is listed as “Acrobat 4” in the Save As dialog box, and PDF 
1.4 is listed as “Acrobat 5.”

 

3. InDesign files may also contain links to native Illustrator 9.x or 10.x files.

nhirooka
Need cross ref here?
If so, where to??
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The more you understand flattening and the characteristics of the target output device (for example, its resolution 
and its ability to reproduce the colors chosen for a job), the easier it is to choose how and when you flatten customers’ 
documents. Also, the later in your workflow the flattening occurs, the more likely you are to achieve acceptable, 
repeatable results. 

 

Note: 

 

For a complete list of file formats that may contain transparent objects in either a live or flattened form, see the 
table “Table1: Input File Formats and Transparency Compatibility by Application” on page 69.

 

TRANSPARENCY CAN SHOW UP IN MANY WAYS

 

—

 

OPACITY, STYLES, BRUSHES, LIVE EFFECTS, AND BLENDING MODES.

 

While many customers apply transparency directly to objects using the Transparency palette in Illustrator or InDesign, transparency 
can also show up in other, less obvious ways. Transparency might be introduced as a side effect of using some styles, brushes, or live 
effects, and it might also be introduced when a designer incorporates previously created content that contains live transparency--
either by importing it directly or via the clipboard. The best way to determine if transparency is applied is to select the object and 
inspect its direct and indirect properties, or use the Flattening Preview palette (available in Illustrator 10). Also, in InDesign, look at the 
Pages palette - if a page has the transpanreyc checkerboard pattern on it, then an object on that page has transparency applied to it.

Another way that transparency can be applied to objects is through blending modes--something you are probably familiar with from 
Photoshop. When a blending mode other than “normal” is applied to one or more overlapping objects, striking visual effects can be 
created--effects that require the use of flattening to be reproduced for printing. 

You need to know two important things about blending modes and flattening. First, when a blend involves spot colors, what you see 
on-screen or in a composite proof may not match what the press reproduces. Second, certain blending modes--difference, exclusion, 
saturation and luminosity--may introduce or eliminate process colors when the resulting blend is flattened, and unexpected results 
may occur when separations are created. See “Section 3.1: Printing separations” on page 38 of this guide for information.

 

WHAT IS A ‘TRANSPARENCY INTERACTION’?

 

Throughout this guide, we focus on objects and placed files to which transparency is directly applied (see the box above for details) 
and on objects and placed files that interact with transparency. Objects and placed files that interact with transparency may be affected 
by the transparency flattening process, resulting in changes in appearance or editability. Therefore, make sure that you understand the 
meaning when we say an object or a placed file “interacts with transparency.”

In Illustrator 10.x, the best way to determine if an object is a source of transparency is to use the Flattening Preview in Illustrator 10 via 
the "Transparent Objects" preview choice. In InDesign, check the Pages palette for the transparency checkerboard. An object is a source 
of transparency if any of the following applies:

- it has transparency directly applied to it

 - it has a non-normal blending mode

 - it has an opacity mask

 - it is set to overprint and "Preserve Overprint When Possible" in Illustrator 10 is not enabled or "Simulate Overprinting" in InDesign 2 
is enabled.

 - its fill or stroke has a style, a brush, a pattern or a filter effect that itself has any of the above properties.

 - it is inside a group or a layer, or a placed file, that has any of the above properties.

The best way to determine whether an object is involved in transparency is to use the flattening preview palette in Illustrator 10, via 
the "All Affected Objects" preview choice. Determining reliably if an object is involved in transparency by visual inspection is not always 
possible, but the rule that almost always works is:

An object is involved in transparency if:

- it is a source of transparency.

- it is overlapped by a source of transparency

- it is very close (usually within 1/72 inch) of a source of transparency and before it in drawing order.

Illustrator 10.x includes a Flattening Preview palette, which lets you determine visually if objects and placed files interact with trans-
parency, and it lets you preview the overall effect of flattening. This palette installs with Illustrator 10.x, but you must enable it by 
moving or copying it into the plug-ins folder. Section 2 of this guide provides more details on enabling and using the Flattening 
Preview palette.
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Transparency and print output

 

All transparency must be flattened

 

The Adobe PostScript

 

®

 

 language doesn’t currently support Adobe’s transparency in native device-independent 
format. For this reason, PostScript desktop printers, Adobe PostScript Level 2 RIPs, and most Adobe PostScript 3 
RIPs (or printing systems based on these RIPs) cannot accept and process “live” transparency information - trans-
parency must be flattened. Most RIPS that accept native PDF 1.4 files can process live transparency from the PDF 
file. Note that each RIP manufacturer will have their own methods of controlling the settings for flattening the trans-
parency from the PDF to final PostScript output. See Section 3 for RIP specific information.

To print correctly, all transparent objects in a file—as well as any linked files that interact with transparency—must 
be flattened at some point in every workflow. Flattening converts the objects from a device-independent format into 
another format that is visually equivalent but doesn’t contain transparency. This format can be represented in 
PostScript. In Adobe applications, flattening of transparent content occurs under the following conditions:

 

•

 

A file is printed from its native application (for example, Illustrator 10.x or InDesign 2.x) or an application that 
supports the originating application’s native format (for example, Illustrator 10.x art placed into InDesign 2.x) 

 

•

 

A file is saved in a non-native format so it can be placed in or linked to other application files in the design or 
prepress workflow. Typically, a file is saved in a non-native, flattened format using the Save As or Export command 
to make an EPS or Adobe PDF 1.3 file, or when the file is converted to PostScript by printing to disk. Flattened 
formats include PostScript, EPS, DCS, PDF 1.2 and 1.3, GIF, JPEG, BMP, and non-Photoshop 6.0 TIFF images. 

 

Note: 

 

PDF 1.4, a format that can represent transparency directly, contains flattened objects only if the source PostScript 
file was first saved to disk, regardless of the application used.

 

NOT ALL EPS FILES ARE CREATED EQUAL

 

Illustrator 10.x can save files in its own (Illustrator 10) EPS format, as well as in EPS formats that are compatible with earlier versions of 
Illustrator, such as Illustrator 8 or Illustrator 7. Only Illustrator 10 EPS is suitable for use in a high-end workflow though, because of the 
management of spot colors and overprinting. (Even though Illustrator 9.x also supports transparency, we recommend Illustrator 10.x 
because of its many performance improvements.)

Transparency is always flattened when a file is saved to EPS. An Illustrator 10.x EPS file, however, (unless resaved in another application) 
retains transparency information within its code, so the live transparency is restored if the file is reopened in Illustrator 10.x. When 
placed into InDesign, the same EPS file is considered flattened.

InDesign 2.x can export two different kinds of EPS files--only one of which is generally suitable for high-end printing workflows. By 
default, InDesign 2.x exports EPS files in which transparency is flattened and overprinting instructions are preserved wherever possible-
-in some limited cases, the flattening process will preprocess these. These default EPS files are suitable for output on printing presses. 
If you select Simulate Overprint in the Export dialog, InDesign 2.x can optionally export EPS files in which all overprinting instructions 
are prepreprocessed and the appearance of overprint is simulated for output on composite devices. As a rule, you shouldn’t use this 
option for high-end printing workflows.
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How flattening changes objects in a design (The Basics)

 

At its simplest, the process of flattening converts all the overlapping elements in a stack of transparent objects into 
a format that captures the look of the original transparency for printing.

To achieve this effect, the Adobe flattening technology, which all Adobe’s transparency-savvy applications 
implement, examines the interactions at every point of the transparency and does several things to the 
objects involved:

 

•

 

The Flattener cuts the original transparent objects apart, and represents overlapping transparent regions by 
creating a new set of discrete, abutting objects called “atomic regions”, each with its own color. (See the 
following example.)

 

Flattening cuts transparent objects apart to represent overlapping areas as discrete pieces that are either vector objects or rasterized areas. 
The flattened view is an exploded diagram of how the objects are splt into flattened atomic regions. This example involves vector objects only. 
As a design becomes more complex (mixing images, vectors, type, spot colors, overprinting, and so on), so does the flattening and its results.

 

•

 

The flattener retains the integrity of the original transparent objects whenever possible (for example, type remains 
type, vectors remain vectors). However, based on the complexity of a design and the flattener settings used, it may 
rasterize type or vector objects, convert type or strokes to outlines, or expand patterns.

 

•

 

The flattener may need to process overprinting objects as it would process overlapping transparent objects, 
especially if those objects set to overprint are involved with transparency. Details of this situation are reviewed 
later in this section—see “Overprinting may not be preserved:” on page 9.

The flattening process is covered in much greater detail in Section 2of this guide. Be sure to review that 
section carefully.

 

. . . AND NEITHER ARE ALL PDF FILES

 

Starting with PDF 1.4 (also known as Acrobat 5 PDF), PDF is able to accurately represent transparency created by any Adobe trans-
parency-savvy authoring or layout application. Illustrator 10.x and InDesign 2.x, can both export and import live transparency as PDF 
1.4. Among other benefits, this format preserves spot colors and overprinting without flattening. As a service provider who accepts PDF 
1.4 (and newer) files, you have complete control over the flattening process that must eventually occur to output the files. This 
flattening can be done most easily by placing a PDF 1.4 file into a blank InDesign 2.x document, and then making separations directly 
or flattening the document into EPS or PostScript for further processing.

If you work with PDF 1.3 (also known as Acrobat 4 PDF), you should be aware that any transparency in the native document from which 
the PDF was created will already be flattened. PDF 1.3 files may not be acceptable for high-end prepress workflows, because 
overprinting and spot colors aren’t always preserved. Illustrator 10.x, for example, doesn’t preserve overprinting and spot colors when 
it exports to PDF 1.3. InDesign 2.x, however, does.

One final point: PDF 1.4 files that were created using Distiller 5.x will not contain live transparency. That’s because Distiller operates on 
PostScript which only contains flattened transparency.

Original Artwork Flattened Artwork
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How transparency and flattening affect workflow and print output

 

Flattening alters a file with transparency to enable prepress workflows, which may visibly reduce output quality. 
If the output is not what is expected, you can often correct the situation if the original files are available. Sections 2 
and 3 discuss flattening and its side effects in detail.

 

Transparency is no longer “live” and editable:

 

Although the result still looks transparent, the formerly transparent 
objects in flattened designs are opaque, and they won’t be transparent to other objects in other applications (that is, 
the transparency is no longer “live” to other objects). In addition, some of the original objects may be transformed 
into less editable formats. (For example, vectors can become rasterized and type can become outlines or be rasterized 
through flattening.) 

Adjusting transparency attributes and objects after flattening requires making changes to the original file, and then 
exporting or printing (flattening) it as a new file. These steps are analogous to standard editing practices when placed 
or imported graphics need to be changed. 

For more information, see the inset “Going Native—Keeping Transparency Live and Editable” on page 15.

 

Rasterization may cause visible changes: 

 

The flattener’s need to convert vectors to rasterized areas (or type to 
outlines) can sometimes produce undesirable visual results, such as jaggies (resolution mismatching between 
objects), color stitching

 

4

 

, or thickened stroke widths. These results can occur if the flattener rasterizes only a portion 
of a large, complex design. What the flattener rasterizes is based on the types of objects being flattened (type, 
gradients, spot colors, and so on), on the file’s complexity, and on the flattener settings that are in effect when you 
save-as, export or print.

 

Resolution may not match the device:

 

Sometimes rasterization is needed as part of flattening. The resolution used 
for rasterization must be user-defined because the device resolution is not automatically available at the time of 
flattening. Also, the device resolution may be inappropriately high and may result in huge spool files and significant 
flattening time without a noticeable improvement in quality. Objects that remain in vector format remain device 
independent and will scale correctly to match the resolution of the output device. (See Section 2 for details about the 
resolution settings used by the flattener.)

Fonts may not match: Since flattening on your computer uses your computer's fonts, not the RIP or printer's fonts, 
there may be a mismatch between fonts within the flattened region & fonts processed at the RIP.

Colors may change: The use of transparency can change colors in several ways. First, certain blending modes, such 
as Multiply can result in generating ink on all process plates, even on those not originally specified. Be sure to use the 
Overprint Preview mode for previewing the appearance of spots and overprint.

Second, if ICC color management is used in the workflow, colors involved in transparency may be transformed 
earlier than expected and may not match the actual press conditions after being flattened. In applications like 
Illustrator 10.x, this transformation can happen if you haven’t carefully chosen the working space profile for the 
document. In InDesign 2.x—which supports working in multiple color spaces—the Transparency Blending Space 
profile must be chosen with the same care. This issue is explored more thoroughly in the section “Handling Color 
Conversions.”

Also be aware that in Illustrator 10.x, correct spot color separations are obtained only if a file is exported to specific 
formats: Illustrator 10 EPS (which has been flattened) or PDF 1.4 (in which transparency remains live). For other 
formats, such as Illustrator 8 EPS or PDF 1.3, the spot colors convert to process equivalents. InDesign 2.x always 
preserves spot colors as long as Simulate Overprinting isn’t selected on the Advanced panel of the Export dialog box. 
(This option isn’t selected by default and should be used for proof output only..)

 

4. Color stitching is the visible color transition between objects whose coloring would otherwise be identical. It most commonly occurs when a portion of 
a vector object is rasterized by the flattener.
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Overprinting may not be preserved: 

 

As long as a document contains no transparency (including non-normal 
blending modes), then overprinting is preserved by InDesign 2.x. If overprinting is mixed with transparency, 
flattening may cause overprinting to be preprocessed. In some cases, flattening may not provide the intended results 
on the press, especially when spot colors are involved. Below is a summary of the overprint handling behaviors in 
Illustrator 10.x and InDesign 2.x.

In Illustrator 10 there is no way to preserve the native overprint instructions when printing to a composite file - 
overprint can either get ignored or flattened. When printing to a composite printer, there is a checkbox "Ignore 
Overprinting in Composite Output." If this option is checked, overprint information is ignored (i.e. removed) from 
the file when printing. If the option is unchecked, overprint is flattened (i.e. the visual appearance of overprinting is 
preserved), similarly to InDesign's "Simulate Overprint" checkbox in the Print UI. 

If an overprinted object is involved in transparency (as defined on page 5), the overprint is flattened (i.e. the 
overprinted object is broken down into atomic regions and their color is flattened, taking overprint into account.) 
Flattening of overprint does not change the visual appearance or the amount of ink per plate. However, it may result 
in removing some of the native overprint instructions and may cause potential problems with post-processing tools 
that might rely on those overprint instructions.

In other scenarios overprint instructions may be generated as a result of flattening, even if none are originally 
present. This can happen when flattening spot colors that are involved in transparency.

 

The effects of flattening on overprint and spot colors

 

If overprinting instructions are applied to objects in a file that also contains transparency, the flattener may be used 
to preprocess these objects. The flattener, in effect, executes the overprinting instructions and renders the results in 
the flattened output stream, much the same as a PostScript RIP. Below is a list of conditions under which 
overprinting instructions are preprocessed by the flattener:

 

•

 

When overprinting objects have transparency applied directly to them (for example, they are less than 
100% opaque)

 

•

 

When overprinting objects are part of a group to which transparency is applied

 

•

 

When overprinting objects overlap (that is, sit underneath or are within approximately 1/72” of) objects or groups 
that are transparent

 

•

 

When overprinting objects are in a placed file to which transparency is then applied

 

•

 

When overprinting objects are part of a “complexity region” and must be rasterized

 

5

 

•

 

When Simulate Overprinting is selected in the Advanced options of the Export dialog box (InDesign 2.x only).

 

Note:

 

 By default this checkbox is unselected and should remain unselected for high-end printing workflows. It should 
only be selected when proofing to low-end composite devices that cannot simulate overprinting.

 

•

 

When the ‘Preserve Overprinting When Possible’ checkbox is unselected using the ‘Transparency’ options of the 
Document Setup dialog (Illustrator 10.x only).

 

Note:

 

 By default this checkbox is unselected but it should be selected for high-end printing workflows.

 

5. A complete discussion of complexity regions is in Section 2 of this guide.
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In many cases, the results of pre-processing overprinting instructions by the flattener will be identical to what 
happens when a PostScript RIP interprets the same overprinting instructions and may not cause a problem in 
your workflow. 

 

Placed files that interact with transparency may be incorrectly processed by the Illustrator 10 flattener: 

 

If a placed / 
linked file is involved in transparency (as defined on page 5) Illustrator 10 will render it at the botton of the drawing 
order when flattening. Placed files that interact with transparency should be embedded in an Illustrator file in order 
to be properly flattened. The entire image can also be placed into an InDesign file and flattened.

 

Transparency effects may be lost after image replacement:

 

If the flattener encounters a transparent region of a 
document that involves images (for example, transparent type and a drop shadow that falls over an image), it uses 
whatever image data is present during flattening to render the overall effect requested. So if the image involved is a 
low-resolution placeholder or OPI proxy image, that’s the image information the flattener uses. If that proxy image 
is subsequently “swapped out” with a final, high-resolution image (using OPI, APR, or manual methods), the 
rendered transparency effect is lost—at a minimum. If the image is an FPO (low-resolution proxy image), the results 
may be more dramatic. You must fatten the file with high-resolution images before you flatten transparency - Fatten 
before you flatten.”

 

Remember to fatten before you flatten if using an OPI or FPO workflow.

 

Transparency effects applied to placeholder or proxy images are properly rendered only if image replacement occurs 
prior to flattening. The impact on workflow depends on what file formats you use, when flattening is performed, and 
what applications are involved. If the workflow is based on Adobe PDF and you use an OPI server that operates on 
PDF 1.4, you can keep transparency live by using PDF 1.4 until after performing image replacement. If the workflow 
is based on EPS, you must perform image replacement manually from within Illustrator or InDesign prior to 
flattening. (See “Section 3.4: Performing image replacement” on page 58). 
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The cumulative effect

 

The variables listed above aren’t the only ones that can affect flattening results. Others include the complexity of 
the design (for example, many overlapped objects using transparency make a design more complex with respect to 
flattening), whether fonts used in the design are available during flattening, and whether external files used in the 
design are linked or embedded. Even the file format and settings used during flattening can make a striking difference 
in the final printed piece.

As these and other flattening issues accumulate, you can better understand why some transparent elements and files 
might not flatten and print as well as others. Following are some recommendations for achieving successful print 
output for standard jobs.

 

Recommendations for successful print output using transparency

 

The majority of files that use transparency can be output without any problems by following the recommendations 
made below. If customers send you native files only, you have complete control over final output when transparency 
is involved. If customers sending you PDF 1.3 or EPS files (formats that are flattened), you should review these 
recommendations with them beforehand:

 

•

 

Whenever possible, use file formats that preserve live transparency—including native formats for Adobe applica-
tions (Illustrator 9.0-10.x and InDesign 2.x) or PDF 1.4 —as hand-off files or source files for placement in layouts 
or other documents.

 

Reason: 

 

You have control over the flattener and resolution settings, up to the time you print or save the job in a non-
native file format (such as PostScript for trapping).

 

Reason:

 

InDesign 2.x allows you to link directly to Illustrator 10.x and PDF 1.4 files, preserving live transparency 
throughout the page layout workflow. You can then flatten all transparency in a job at once, directly from within 
InDesign.

 

•

 

Save transparent artwork from Illustrator 10.x in Illustrator 10 EPS format if you use older applications for page 
layout, especially if spot colors are involved and you intend to make separations. 

 

Reason: 

 

Currently, InDesign 2.x is the only page layout application that can interpret unflattened transparency in 
native Illustrator files and PDF 1.4 files.

 

Reason: 

 

Illustrator 10 EPS is the only flattened file format that can be exported from Illustrator 10.x with spot color 
plates preserved. Because spot colors are converted to process colors if you export to AI 8 EPS or PDF 1.3, Illustrator 
10 EPS is the only flattened format suitable for separations in older page layout applications. More importantly, you 
can open Illustrator 10 EPS files in Illustrator 10.x and adjust flattener and resolution settings to match output condi-
tions in your workflow.
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•

 

Save page layouts with transparency from InDesign 2.x as PostScript files or PDF 1.3 files using the “High 
Resolution” flattener style if you use prepress tools that can’t interpret PDF 1.4.

 

6. An Illustrator 10 EPS file remains editable only if it retains the Illustrator 10-specific information that is embedded in the file. After the file is saved to 
a non-Illustrator 10 EPS format, this information is removed, and the file loses its ability to be flattened again. For instance, placing an Illustrator 10 EPS file
into a page layout application, and then saving the resulting file as EPS removes the Illustrator 10 information. That EPS file can be reopened in Illustrator
10.x, but you cannot edit its transparency or adjust flattener properties. Many techniques described in this guide depend on the integrity of the exported 
Illustrator 10 EPS file.
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Reason:

 

PostScript and PDF 1.3 files created in this manner in InDesign 2.x provide high-quality results, preserve 
overprinting and spot colors where possible, and separate correctly.

 

•

 

When using PDF 1.3 for separations, make sure that the resulting PDF file supports spot colors and overprinting. 
The easiest way is to use InDesign 2.x and the appropriate PDF style for this purpose. If you need to make a PDF 
1.3 file from an Illustrator 10.x document, you must first export the document to Illustrator 10 EPS (or print 
PostScript to disk), and then use Adobe Acrobat Distiller

 

®

 

 to make the PDF 1.3 file. 

 

Reason: 

 

When you export to PDF 1.3 directly from Illustrator 10.x, spot colors and fonts aren’t preserved in the 
flattening process.

 

•

 

When applying drop shadows and feathering to objects in Illustrator, be sure to use effects rather than filters.

 

Reason:

 

Illustrator effects have settings that can be dynamically changed / fixed at print / output / export. Filters 
create resolution-dependent raster objects, and their appearance is dependent on the Raster Effects Resolution in 
effect at the time the filter is used. For example, you can modify the resolution settings of a previously applied effect 
in order to make changes just before print, but a filter bakes the resolution into the image at the time the filter is used, 
making it impossible to change that setting later on. 

 

Reason: 

 

The set of spots is fixed at flattening time and cannot be changed after flattening.

 

•

 

If you flatten a document with spot colors, inspect it as follows:

Determine if spot colors are used (Illustrator only). If spot colors are used, the file must be exported to Illustrator 10 
EPS or PDF 1.4. Spot colors are lost if you export from Illustrator 10.x to any other format. You can also place the 
unflattened native file directly into InDesign 2.x. (See “Problem 3.1.1: Spot colors convert to process.” on page 39.)

Make sure all spot colors correspond to actual plates. Convert spots to process if they don't have a corresponding 
plate (note: this may affect the appearance), or in InDesign 2.0, map spot colors to appropriate target plates using 
the Ink Manager in the Print UI.

Determine if overprinting and transparency are used together in the document (Illustrator only). During flattening, 
the overprinting might be simulated, and the overprinting instructions might be removed. (See “Problem 3.1.2: 
Overprinting instructions are lost.” on page 40.) 

Determine whether Difference, Exclusion, Hue, Color, Saturation, or Luminosity blending modes are used in the 
document. To help you determine if blending modes are used, enable overprint preview mode. These blending 
modes may result in marking all process plates, even those not specified in the color of the object assinged the 
blending mode.

Make sure that all fonts are present and properly installed. Otherwise, the flattener substitutes them with fonts that 
may not fit the original text’s bounding box, and this substitution cannot be corrected later. 

Look for any low-resolution proxy images that interact with transparency. For proper results, such a document 
must be “fattened”—contain all high-resolution final images—before it is flattened. You must either perform 
image replacement manually before flattening a document or, if you use a PDF-based OPI server, you can keep 
transparency live using Adobe PDF 1.4 until files are fattened. If you flatten files in Illustrator 10.x, you must also 
place-embed rather than place-link EPS images that interact with transparency. (See “Section 3.4: Performing image 
replacement” on page 58.)

 

Note: 

 

The InDesign 2.x logic that generates OPI comments if Omit Images is selected doesn’t process any placed images 
that interact with transparency. These images aren’t replaced when OPI is performed.

 

If you use color management, be sure that the file’s working color space—or transparency blending space in InDesign 
2.x—is set to the intended output device before flattening. This procedure ensures that transparent objects are 
assigned suitable in-gamut colors. (See “Section 3.5: Handling color conversions” on page 60.)



 

13
General Guidelines for Reliable Output

 

If native Illustrator or PDF 1.4 files are placed in InDesign 2.x, and the files contain live transparency, make sure that 
they are in the same working color space as that being used for transparency blending. The same color space ensures 
that overprinting in placed files correctly interacts with objects over which they may be placed.

 

Note:

 

 To improve display performance, InDesign 2.x lets you disable the on-screen preview of transparency and trans-
parency-based effects using the new Display Performance preference setting. Be sure to set Display Performance to High 
Quality before you inspect a document.

 

•

 

Place-embed (don’t place-link) EPS images that are part of an Illustrator 10.x design if they interact with 
transparency as described earlier in this document (See “What is a ‘Transparency Interaction’?” on page 5.)
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Reason: 

 

The flattener in Illustrator 10.x cannot read the data inside a place-linked file. Therefore, place-linked 
files involved in transparency print first, beneath everything else on the page, as if they were in the background. 
Place-embedding the file in Illustrator 10.x enables the flattener to correctly process the file’s contents for trans-
parency-based effects.

 

Note:

 

 In Illustrator 9.x, a yellow ‘warning triangle’ appears next to the name of any linked files which, because of their 
interaction with transparency, need to be embedded to flatten properly.To improve performance in Illustrator 10.x, this 
feature is disabled by default. See Section 2 for details.

 

Note:

 

 The colors in place-embedded files automatically convert to match the color model in the Illustrator 10.x 
document in which they are placed if they don’t already match.

 

•

 

Review a document’s current flattener settings and adjust them to best match final output conditions. 
(See “What are your points of control?” on page 17.)

 

Reason: 

 

The flattener settings you choose—especially Raster/Vector Balance—can greatly affect the quality of 
the printed piece. When you flatten with intent to separate the output, use the highest fidelity (rightmost) setting 
for the best results. For quicker proofing, lower fidelity settings may be acceptable.

 

Note:

 

 InDesign 2.x provides a set of flattener styles to make it easier to manage all flattener controls and settings. 
These styles are discussed in greater detail in Section 2.

 

Note:

 

 In InDesign 2.x, individual spreads can have their own flattener settings. To check these flattener settings, use the 
flyout menu of the Pages palette.

 

•

 

Review the current Flattener, Rasterization, and Mesh Resolution settings, and adjust them as appropriate for 
the final output device’s resolution and line screen. (See “Resolution settings and their interactions” on page 23.) 

 

Reason: 

 

If a setting is too low, stitching artifacts may occur. Generally, the Flattener, Rasterization, and Mesh 
Resolution settings should be no less than twice the intended line screen (for example, 300 ppi rasterization for 
150 lpi output) and no more than the full resolution of the intended output device (although the result can be 
significantly larger flattened files). Your shop’s standard may vary.

 

•

 

Review the current Raster Effects Resolution settings (if Illustrator filters are used), and adjust them as appropriate 
for the intended output device’s resolution and line screen. Note that adjusting these settings changes the size 
and appearance of certain pixel-based raster effects in the file. (See “Resolution settings and their interactions” on 
page 23.)

 

Reason: 

 

If a setting is too low, stitching artifacts may appear. Typically, the resolution for raster effects should match 
the resolution you use for drop shadows created in Photoshop, and it might be lower than the resolution for images. 
Your shop’s standard may vary. 

 

Note:

 

 In Illustrator 10.x and InDesign 2.x, transparency effects, like drop shadows and feathered edges, are pixel-based, 
and their resolution is controlled by the gradient resolution flattener setting.

 

7. This technique doesn’t work with DCS 2.0 (pre-separated), duotone, tritone, or quadtone files because Illustrator cannot embed these types of graphics.
These file formats are often used when creating images in Photoshop for use in Illustrator.
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•

 

Install the Illustrator 10.x Flattening Preview palette plug-in to help you make better flattener choices
from Illustrator.

 

Reason:

 

The Flattening Preview palette plug-in provides immediate visual feedback, allowing you to evaluate the 
effects of the flattener settings you select. This plug-in is discussed further in Sections 2 and 3. See also the document 
“Flattening_Preview.pdf,” which installs with Illustrator 10.x.

 

•

 

If you are unsure about the effects that flattening will have on a document, run proofs at different flattener 
(and related rasterization) settings, and/or generate and preview separations on-screen to check the results before 
going to press.

 

Reason: 

 

Some files with transparency print just fine the first time out. Others require fine-tuning. Making a 
composite proof or previewing separations on-screen may be a less expensive way to verify any changes that may 
be needed before making actual film or plates. 

 

HOW TO CONTROL FLATTENING IN ADOBE APPLICATIONS

 

Section 2of this guide provides details about the settings that control variables during flattening. While the underlying technology to 
flatten transparency is the same in both Illustrator 10.x and InDesign 2.x, the controls have some important differences. Here is a brief 
review of those differences:

- The Raster/Vector Balance control is continuously variable in Illustrator, but it has only five settings in InDesign.

- The Raster/Vector Balance control scales from 1 to 100 in Illustrator and 1 to 5 in InDesign. Illustrator’s 1 and 100 are the same as 
InDesign’s 1 and 5.

- In Illustrator 9x and Acrobat 5.x, the Raster/Vector Balance control is labeled Quality/Speed. Previous versions of this guide also 
referred to it by that same name. 

- In InDesign, the Gradient Resolution is used for ID drop shadows and feathers.

- Convert All Text to Outlines in Illustrator is called Force Text to Outlines in InDesign.

- Convert All Strokes to Outlines in Illustrator is called Convert Strokes to Outlines in InDesign.

- Preserve Overprints When Possible is a flattener option in Illustrator only; InDesign provides a different control--Simulate Overprint--
for exporting EPS files or printing.

- Rasterization Resolution in Illustrator is called Flattener Resolution in InDesign.

- The Mesh Resolution in Illustrator is called the Gradient Resolution in InDesign.

- The Raster Effects Setting is in Illustrator only. 

 

CHOOSING FILE FORMATS WISELY

 

When it comes to transparency, Illustrator10.x and InDesign 2.x native file formats are the best choice for prepress because they aren’t 
flattened. This feature gives you complete control over that most critical aspect of the workflow. However, your existing investment in 
prepress tools and printing systems requires that these native files be converted to PostScript, EPS or Adobe PDF soon after you receive 
them. Here are some things to consider:

Illustrator 10.x artwork that is saved as Illustrator 10 EPS is flattened--allowing it to be placed in older layout applications--but it may be 
reflattened at any time to inspect and correct flattening problems, should they occur. This condition is because Illustrator 10 EPS format 
holds all the preflattened transparency information inside of it. You can open an Illustrator 10 EPS file in Illustrator 10.x, restore the “live” 
transparency objects for editing, and resave it with new flattener settings.

InDesign 2.x layouts saved as either EPS or PDF 1.3 are flattened, but they also retain overprinting and spot colors correctly--unless 
Simulate Overprinting is selected in the Export dialog box. 

PDF 1.4 files created directly from either Illustrator 10.x or InDesign 2.x remain unflattened - much the same as native files. Printing 
systems based on Extreme 5 or Adobe Level 3 RIPs (3015+ with PDF printing extensions) may be used to flatten these files just prior
to final output.
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Where to go next

 

The more you know about transparency and the effects of flattening, the better prepared you are to intercept and 
correct problems. 

This section provided a high-level overview of what to expect when receiving and processing transparent files. 
We encourage you to read Sections 2 and 3 to understand the following:

 

•

 

How to address the effect of flattening on specific workflow steps.

 

•

 

How to use the flattener and related controls in Adobe applications.

 

•

 

Specific known issues, workarounds, and solutions

 

•

 

File formats and their compatibilities with transparency and overprint

 

GOING NATIVE—KEEPING TRANSPARENCY LIVE AND EDITABLE

Adobe’s transparency attributes stay “live” and fully editable while in their native application or in one that supports the native 
file formats:

They are “live” in that they can interact with other objects that are placed beneath them, allowing those objects to show through 
the transparency. These objects also retain a very high degree of (or complete) device independence.

They are editable in that the transparency attributes, the transparent objects, or both can be freely altered to the extent that the 
receiving application supports such editing. (For example, some applications allow you to reduce the opacity of type, alter the color 
or shape of a drop shadow, or edit transparent text.)

Live and editable depends on format and application

Transparent content is both live and editable within the application in which it is created. It can also be both live and editable when 
placed as a native file within another document. The extent to which it is editable in the receiving application depends on the editing 
features of that application.

Transparent content is neither live nor editable when placed as a non-native (i.e., flattened) file within another document. The notable 
exception to this is the Illustrator 10 EPS format. This format includes additional application-specific information that allows Illustrator 
only to “reconstitute” transparency in a live and editable form. 

THE FUTURE OF PRINTING LIVE TRANSPARENCY: ADOBE POSTSCRIPT 3 RIPS

PostScript 3 RIPs that support Adobe PDF 1.4 (Acrobat 5) files can accept and process “live” transparency. This capability is built into 
the Adobe PostScript version 3015 RIP, which was released to Adobe OEM partners in spring 2000. Check with the vendor of any Adobe 
PostScript-based high-end printing system to determine if PDF 1.4 or live transparency printing support is available.
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Section 2: Controlling Flattener Settings 
and Results

About this section

This section explains how to flatten art in specific Adobe products, so you can make the best choices for your 
workflow or transparency jobs.

Usually, you will do the flattening to optimize transparent files for your target press conditions. You have control over 
the flattening of the following types of files:

• Native Adobe Illustrator 10.x (transparency unflattened)

• Native Adobe InDesign 2.x (transparency unflattened)

• Illustrator 10 EPS (can be reflattened)

• Adobe PDF 1.4 files created from Illustrator 9.x, Illustrator 10.x, or InDesign 2.x (transparency unflattened)

PDF 1.4 files that contain live transparency (these files are not flattened8) can be flattened using Illustrator 10.x, 
InDesign 2.x, or Adobe Acrobat 5.x. Generally, however, Adobe recommends using InDesign 2.x or Illustrator 10.x 
because the flattening options in these products are more flexible and appropriate for high-end prepress workflows. 

Ideally, all flattening should be done as close as possible to the point at which film or plates are made. Until all 
prepress tools are transparency-aware, however, flattening is likely to occur upstream of this point, when files are 
saved to PostScript, PDF, or EPS.

What are your points of control?
All Adobe products use similar flattener technology, but flattening controls in each application may differ slightly. 
The flattener uses interrelated settings, as follows:

1 The Raster/Vector balance controls the degree to which complex areas of transparency get rasterized. Flattening 
performance can be effected by the complexity of the objects and by the Raster/Vector setting. For complex 
documents, flattening in vector form requires more time and memory than rasterization. The opposite can be true 
for simple documents and high rasterization resolutions. In Illustrator 10.x you can use the Flattening Preview 
palette with the Complex Regions preview option to show which areas in the document would get rasterized for a 
given flattening level. Certain object intersections (atomic regions) can get rasterized also because they cannot be 
represented in native form in PostScript. Such rasterizations are independent of the Raster/Vector slider.

Note that some amount of rasterization may be unavoidable, even when this control is set to Vector (rightmost 
position).

Note: In Illustrator 10.x, this control has a scale of 0 to 100; in InDesign 2.x, this control has a scale of 1 to 5. Also note 
that in Illustrator the scale is gradual, while in InDesign 2.x the scale has five fixed positions. The scale is otherwise 
identical—for example, 100 in Illustrator is the same as 5 in InDesign. (In Illustrator 9.x and Acrobat 5.x, this control 
is labeled “Quality/Speed.”)

8. Only PDF 1.4 files that are produced directly from Illustrator 9.x, Illustrator 10.x, or InDesign 2.x remain unflattened and retain their live transparency.
PDF 1.4 files created from flattened PostScript files and Adobe Acrobat Distiller never contain live transparency.
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2 Flattener options provide important controls that may improve the final appearance of transparency regions after 
flattening. The four possible flattener options include the following:

• Force or Convert All Text to Outlines: Controls the processing of type and causes all type to convert to outlines, 
whether it interacts with transparency or not. In some cases, this option eliminates flattening artifacts that are 
apparent on-screen and when printing to lower resolution output devices, such as a composite proof.

• Convert Strokes to Outlines: Controls the processing of strokes and causes all strokes to convert to outlines, 
whether they interact with transparency or not. In some cases, this option eliminates flattening artifacts that are 
apparent on-screen and when printing to lower resolution output devices, such as a composite proof.

• Preserve Overprints When Possible: Controls the flattener’s preprocessing of overprinting instructions applied 
to objects in a document.

Note: InDesign 2.x does not have this control; it always acts as if "Preserve Overprints" is selected, unless "Simulate 
Overprinting" is selected at print/export time.

• Clip Complex Regions: Controls the flattener’s analysis of complexity regions (discussed later in this section). 
When enabled, this option creates more accurate clipping paths around these portions of a transparent design. 

3 Resolution settings used during flattening: Controls the resolution (in pixels per inch) that rasterized trans-
parent areas receive during flattening. The three kinds of rasterization settings include the following: 

• Rasterization Resolution: Determines the resolution applied to areas that need to be rasterized because they are 
too complex for the current Raster/Vector Balance setting. The Rasterization Resolution is intended primarily for 
vector objects, but in some cases, it may also be applied to type or images. Typically this resolution should be set 
to match your output device / RIP resolution.

Note: In InDesign 2.x, this setting is labeled“Flattener Resolution.”

• Raster Effects Resolution: Determines the resolution applied to all raster effects, such as drop shadows, vignettes 
or feathered edges, that are used in a file, whether or not the effects are involved in the transparency. 

Note: InDesign 2.x uses the Gradient Resolution for this purpose.

• Mesh Resolution: Determines the resolution applied to any meshes and gradients that are involved in 
the transparency.9

Note: InDesign 2.x, does not have this control; it always acts as if "Preserve Overprints" is selected, unless "Simulate 
Overprinting" is selected at print/export time.

How the flattener applies these three settings is explained in this section under “Resolution settings and their inter-
actions” on page 23.

Note: In Illustrator 10.x, the precision—or flatness—of all vector objects during printing and PostScript export is 
controlled via the Output Resolution setting.

9. The Mesh (or Gradient) Resolution setting isn’t new with transparency. This setting manually controls the resolution of all meshes and gradients printed
to PostScript Level 1 and Level 2 RIPs that don’t support the PostScript 3 “Smooth Shade” operator. This setting is ignored if mesh- or gradient-filled objects
aren’t involved in transparency and are printed to a PostScript 3 RIP.
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Your degree of control over flattening can also depend on the complexity of the original transparent content, and on 
which file format was used to save the flattened document. Similar to compressing a JPEG file, in which you find a 
balance between quality and compression, flattening often requires you to find a balance among the many settings 
to achieve the best quality output.

Raster/Vector Balance settings
During processing, the flattener subdivides a design into regions and examines each region for any transparent 
objects. For regions that contain transparency, the flattener assesses whether the objects involved can be kept in 
their original form (for example, vectors as vectors, type as type), whether they can be converted to a related form 
(for example, type to outlines), or whether the entire region must be rasterized because of its complexity. 

Illustrator 10 Flattener Preview shows the flattening results 
of your Raster/Vector Balance settings.

ADOBE PRODUCTS DIFFER IN THEIR SUPPORT FOR LIVE TRANSPARENCY

Adobe products support transparency at varying levels. Some applications can create, print, and save (flatten) transparency for use in 
other applications. Some merely accept flattened information as imported files and pass it along for printing. Others can both accept 
native files with live (unflattened) transparent objects and support their manipulation and adjustment within a layout. 

Full support for live transparency exists only in Illustrator 10.x and InDesign 2.x. Adobe Acrobat 5.x also supports live transparency in 
the form of PDF 1.4, but it doesn’t have several of the flattener controls and options—most importantly Rasterization Resolution—that 
Illustrator 10.x and InDesign 2.x provide.
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The Raster/Vector Balance setting lets you determine how hard the flattener works to keep objects in their original 
form—that is, to maintain the fidelity of the objects used to represent the design after it is flattened. Generally, the 
Raster/Vector Balance setting works as follows:

• At the lowest-fidelity, leftmost position (labeled Raster), the flattener rasterizes all objects in the file. 

• At the highest-fidelity, rightmost position (labeled Vector), the flattener tries to keep all objects in their original, 
highest-fidelity form. In a few cases, the flattener may not be able to represent all objects purely as vectors. 
For example, the fill required to represent a transparent vector shape may be rasterized though the clipping 
path remains so that the resulting object remains vector.

• Intermediate settings affect the degree to which the flattener rasterizes (or doesn’t rasterize) areas of transparency, 
as determined by the number of paths, the number of objects, the degree of overlap between the objects, and the 
type of objects in that area. 

The design complexity of a document is the primary influence on what happens during flattening. In many simple 
uses of transparency, the results may be no different at any setting above the lowest-fidelity position (that is, no 
rasterization will occur). However, Adobe recommends that you use only the lowest- or highest-fidelity setting. 
Lowest-fidelity is most appropriate for proofing to a low-resolution device, because the resulting rasterized file will 
not be excessively large. Highest-fidelity is best for final high-resolution work, because very little or no rasterization 
will occur.

For final high-resolution output, you shouldn’t select anything other than the highest-fidelity setting unless you want 
to reduce the time or memory required to flatten a particularly complex transparent design. Take care, however, to 
lower the fidelity no more than necessary to avoid an unacceptable degree of rasterization.

Note: You can use the Flattening Preview palette in Illustrator 10.x to determine the effects of intermediate 
Raster/Vector Balance settings. See “Flattening controls in Illustrator 10.x” on page 26 for more details.

Understanding flattening and printing performance trade-off

If Raster/Vector Balance is set to Vector (the rightmost position), the time and memory required to flatten a file may 
be quite noticeable if the file contains extensive transparency. The resulting flattened file, however, is usually smaller 
and take less time for spooling because it is rasterized as little as possible. If the Raster/Vector Balance is set to Raster 
(the leftmost position), the time and memory required to flatten this same file can be quite less. The resulting 
flattened file, however, may be much larger and take more time for spooling.

In both cases, the flattened file may take longer to print than expected because of memory demands placed on the 
RIP. These demands occur either because the Raster setting has created an excessively large rasterized file or because 
the Vector setting has created a file filled with a large number of small vector objects and clipping paths. Also note 
that the rasterization resolution in effect when a file is flattened also influences final file size. See “What resolution 
settings are correct?” on page 24.
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Flattener options
Illustrator 10.x and InDesign 2.x include the following options:

• Convert All Text to Outlines (Illustrator 10.x) or Force Text to Outlines (InDesign 2.x): If this option is selected, 
all type converts to outlines, whether it interacts with transparency or not. If this option is deselected, type 
converts to outlines only as necessary in transparent regions.

Reason to enable: Flattening may require that type involved in transparency be converted to outlines. Converted 
text can appear thicker or bold on-screen and when printed to lower-resolution output devices. Furthermore, 
stitching problems may occur when only a portion of the text is converted to outlines.You can often avoid this 
problem by converting all type to outlines.

Side effects: Converting all type to outlines may degrade its appearance (it may appear bolder) and may increase 
flattening time or memory requirements. You may therefore want to convert text manually to outlines in Illustrator 
or InDesign only where type interacts with transparency and this problem occurs.

Note: You can use the Outlined Text preview option (available in Detailed Preview mode) of the Illustrator 
Flattening Preview palette in Illustrator 10.x to determine where text would be converted to outlines and whether 
to use this option.

• Convert All Strokes to Outlines (Illustrator 10.x) or Convert Strokes to Outlines (InDesign 2.x): If this option 
is selected, all strokes convert to outlines whether they interact with transparency or not. If this option is 
deselected, the flattener converts strokes to outlines only as necessary in transparent regions.

Reason to enable: Flattening may require that strokes involved in transparency are converted to outlines. Converted 
strokes can appear thicker and less precise on-screen and when printed to lower-resolution output devices. Stitching 
problems may occur when only a portion of a stroke is converted to outlines. You can avoid this problem by 
converting all strokes to outlines.

Side effects: Converting all strokes to outlines may degrade their appearance (they may appear thicker) and may 
increase flattening time or memory requirements. You may therefore want to convert strokes manually to outlines 
only where they interact with transparency and this problem occurs.

• Preserve Overprints When Possible (Illustrator 10.x): If this option is selected, overprinted objects that are not 
involved in transparency are not flattened. If this option is deselected, the flattener preprocesses all overprinting 
instructions, effectively simulating overprinting. Overprinting may be abbreviated as “OP.”

Reason to enable: The flattener retains as much overprinting as possible without preprocessing (simulating) during 
flattening. This results in retaining more of the document in native (editable) form and in using less computing 
resources while flattening
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Side effects: Because you can’t always preserve overprinting when transparency is involved, enabling this option 
may produce inconsistent results on press.

Transparency flattening effects on overprint.

Note: In InDesign 2.x, the default flattening behavior is to always preserve overprinting, so the Simulate Overprint 
option is deselected by default. Select this option when printing a proof, or to simulate overprinting when exporting 
flattened files like EPS. Such EPS files are most useful for creating composite proofs.

Note: In Illustrator 10.x, the default flattening behavior is to always simulate overprinting, so this option is deselected 
by default. Select this option to preserve overprinting in flattened files that are output on printing presses. Illustrator 
10.x can properly preserve overprinting in flattened files only when exporting them to Illustrator 10 EPS format. 
Illustrator 10.x ignores this option for files printed to a composite device and instead uses the Ignore Overprinting in 
Composite Output option in the Print dialog box.

• Clip Complex Regions: If this option is selected, the flattener creates more accurate clipping paths around 
complexity regions—certain rasterized portions of a transparent design (see “Resolution settings and their inter-
actions” on page 23). These regions are created only if the Raster/Vector Balance is set below Vector 
(the rightmost position).

The effects of different flattening settings and results in the Flattener Preview in Illustrator 10.
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Reason to enable: If you must lower the Raster/Vector Balance setting to improve flattener performance or reduce 
memory usage, Clip Complex Regions decreases the possibility of stitching problems along the boundaries of the 
complexity region. It will also eliminate white boxes around the flattened file when placed in an aggregate application 
like InDesign 2.x (see the issue on page 35).

Side effects: The resulting clipping path may be so complex that older RIPs without sufficient RAM may be unable 
to print the resulting file (that is, the RIP will limitcheck).

Note: This option is ignored if Raster/Vector Balance is set to Vector because complex regions, which require raster-
ization and clipping, are created. In Illustrator 10.x, this option is grayed out if Raster/Vector Balance is set to Vector.

Resolution settings and their interactions
Note: Illustrator 10.x and InDesign 2.x use different terms for the primary parameter used to set the resolution of 
rasterized regions of a flattened document. In Illustrator 10.x, this parameter is Rasterization Resolution, and in 
InDesign 2.x, this parameter is Flattener Resolution.

For readability, this section uses Rasterization Resolution to include both terms and notes the differences with InDesign 
2.x only as necessary.

Previous pages of this guide discuss flattening and rasterization in broad terms. These next pages discuss raster-
ization in greater detail.

Rasterizing occurs primarily during flattening for two main reasons:

• When rasterizing atomic regions: Flattening divides the transparency of a document into a collection of discrete 
areas called atomic regions. If an atomic region contains an image or multiple gradient or mesh objects, the region 
is rasterized. The flattener usually applies the Mesh (or Gradient) Resolution to this region, unless the atomic 
region has one or more images, in which case it applies the maximum of their resolutions, up to the current 
Rasterization Resolution. The flattener also clips the resulting raster with the affected region’s outline, thus 
preserving the shape of all vectors—but not their fills—in a resolution-independent form. 

Note: Rasterizing atomic regions happens only if the setting for Raster/Vector Balance is above Raster (otherwise the 
entire document is rasterized).

• When rasterizing a complexity region. A complexity region is an area that isn’t retained in vector form except at 
the highest-fidelity Raster/Vector Balance setting. These regions are typcailly a complex number of objects with 
transparency and flattening would take very long and or require much memory. Flattening a complexity region 
involves rasterizing all vector objects, images, and text inside it at the Rasterization Resolution. For this reason, 
make sure to set the Rasterization Resolution to a value that closely matches the characteristics of the chosen 
output device. See “What resolution settings are correct?” on page 24 for details.

Note: Rasterizing complexity regions happens only if the setting for Raster/Vector Balance is above Raster (otherwise 
the entire document is rasterized) and below Vector (otherwise complexity regions aren’t created).

Following are some additional points about rasterization:

• If type that interacts with transparency must be converted to outlines, but the font is protected or bitmapped, 
the flattener rasterizes the type instead using the current Rasterization Resolution setting. 

• In Illustrator 10.x, any pixel-based raster effects, such as Gaussian Blur, are rasterized with the Raster Effects 
Resolution before flattening and are treated by the flattener as regular images. 
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• When overprinted objects are rasterized, the effect of overprinting is preserved in the resultant image.

• When spot objects are rasterized, spot plates are preserved (unless, of course, flattening is done in a context in 
which spots are converted to process, such as PDF 1.3 export from Illustrator, or the Flatten Transparency 
command in Illustrator). In Illustrator 10.x, spot colors in rasterized regions are preserved correctly if they are 
saved as Illustrator 10 EPS or printed to disk as PostScript. (For more details on overprinting, see “Problem 3.1.2: 
Overprinting instructions are lost.” on page 40.)

What resolution settings are correct? 

Whenever possible, you should set the resolutions to accommodate target press conditions before flattening. If a file 
is in any of the following formats, you can set the resolutions used by the flattener to match target press conditions:

• Native Illustrator 10.x (transparency unflattened)

• Native InDesign 2.x (transparency unflattened)

• Illustrator 10 EPS (can be reflattened by Illustrator, but considered flattened by InDesign)

• Adobe PDF 1.4 files created from Illustrator 9.x, Illustrator 10.x, or InDesign 2.x (transparency unflattened)

Any other file format is already flattened, so the resolution for rasterized areas is locked and may not match target 
press conditions.

Although your workflow requirements may vary, you may want to follow these guidelines:

• The Rasterization Resolution (Illustrator 10.x) or the Flattener Resolution (InDesign 2.x) may be set according 
to two different approaches. The first approach uses a resolution that is close or equal to the output resolution of 
the device. InDesign 2.x, for example, uses a value of 1200 dpi for its highest fidelity flattening style. This 
resolution minimizes stitching problems that occur when type and vector objects are partially rasterized by the 
flattener, but it also increases the sizes of files that are heavily rasterized. The other approach uses a resolution 
based on the standard, “image resolution equals twice the line screen.” Either way, be careful to choose a value that 
doesn’t cause downsampling of an image in a transparency. This value is also used at the upper limit for rasterizing 
atomic regions in all transparency-savvy applications. See “Rasterizing atomic regions with gradients or image 
data” on page 25 for details.

Note: A higher resolution may increase the size of the resulting flattened file—depending, of course, on how much 
artwork is rasterized.

• The Gradient (or Mesh) Resolution should match what is commonly used for drop shadows created in 
Photoshop (for example, 150 dpi). InDesign 2.x uses this value when it flattens drop shadows and feather effects 
applied to page objects. This value is also used at the lower limit for rasterizing atomic regions in all transparency-
savvy applications.

Note: This value is the same value that applications already use for rasterizing meshes and gradients when printing 
documents to PostScript Level 1 or 2 RIPs that don’t support the Smooth Shade operator.

• The Raster Effects Resolution (Illustrator 10.x only) should match what is commonly used for drop shadows 
created in Photoshop (for example, 150 dpi). This value applies to all raster effects used in Illustrator, including 
live raster effects and resolution-dependent filters, such as Gaussian Blur. Changing this value may radically 
change the appearance of some raster effects.
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Rasterizing atomic regions with gradients or image data

The Gradient Mesh Resolution (Illustrator) or the Gradient Resolution (InDesign) is generally used when rasterizing 
an atomic region. If the atomic region contains images, however, the resolution it is rasterized at is that of the highest 
resolution image involved, not exceeding the Rasterization Resolution (in Illustrator) or the Flattener Resolution 
(in InDesign).

Note that a rasterized atomic region is represented as an image clipped by the vector path of the atomic region. 
Therefore paths are preserved in vector form even when atomic regions are rasterized.

Here are some examples to clarify these relationships:

• If a region to be rasterized includes a gradient mesh object, and the Gradient (or Mesh) Resolution is set to 150 
dpi, the region will be rasterized at 150 dpi.

• If a region to be rasterized includes image data at 300 dpi and 600 dpi, and the Rasterization Resolution is set 
to 1200 dpi, the region will be rasterized at 600 dpi. (Otherwise, the images would be incorrectly upsampled.)

• If a region to be rasterized includes image data at 600 dpi and 1200 dpi, and the Rasterization Resolution is set 
to 800 dpi, the region will be rasterized at 800 dpi, requiring downsampling of the 1200 dpi image data.

You can either make sure that the Rasterization Resolution is appropriate for the device before flattening, or you 
can make sure that image data starts at a resolution that has the least discrepancy with the Rasterization Resolution. 
For example, a 600 dpi drop shadow created in Photoshop that gets resampled at 300 dpi during flattening will look 
better than a drop shadow that started at 72 dpi. The best scenario is a close match between image resolution and 
Rasterization Resolution, both of which should be appropriate to the final output device. The Raster Effects 
Resolution (Illustrator 10.x only) and the Gradient (or Mesh) resolution should both be set to a value that is lower 
than and evenly divisible by the Rasterization Resolution (for example, 300 if the Rasterization Resolution is 2400). 

In general, the higher the Rasterization Resolution setting, the better the results (especially if any type is rasterized). 
However, choosing a very high Rasterization Resolution, such as 2400 dpi, often generates significantly larger 
flattened files without providing any visible benefits in the final output. (You may need to experiment with Raster-
ization Resolution settings.)

One way to avoid this problem is to set the Rasterization Resolution to the same resolution as the final version of 
the image, and to replace all proxy / low resolution images with final high resolution images before flattening. (See 
“Section 3.4: Performing image replacement” on page 58.)
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The flattening controls in Adobe products
While Illustrator, InDesign, and Acrobat apply the same flattener technology, they differ in their flattener 
controls and how the controls are implemented. The following subsection provides a high-level overview of 
the relevant controls in each product. You may also find it useful to consult the on-line documentation provided 
with each product.

Flattening controls in Illustrator 10.x

Illustrator 10.x has three locations for controlling the settings that affect transparency flattening:

• To access the Raster/Vector Balance control, the flattener options, and the Rasterization Resolution option, 
choose File > Document Setup, and select the Transparency panel:

The Transparency panel in the Document Setup dialog box provides a control 
for how much art gets rasterized during flattening, along with flattener options 
and the Rasterization Resolution option.

• To access Illustrator’s Gradient Mesh Resolution option, choose File > Document Setup, and select the Printing & 
Export panel: 

The Printing & Export panel provides access to the Gradient Mesh Resolution 
and Output Resolution.
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• To access Illustrator’s Raster Effects Resolution option, choose Effects > Raster Effects > Raster Effects Settings:

The resolution value in Illustrator’s Raster Effects Settings dialog box 
is applied to all rasterized effects in the file. In Illustrator 10.x, 
the default Raster Effects Resolution value is 72ppi. 

• To access Illustrator’s Flattening Preview palette, choose View > Flattening Preview:

Illustrator’s Flattening Preview palette provides access to the most common 
flattening settings, plus visual feedback to help you determine 
how a document will be affected by the current settings.

The Flattening Preview palette is an optional plug-in on the Adobe Illustrator 10 CD-ROM. This plug-in and instal-
lation instructions are in the Utilities/Flattening Preview folder located where you installed Illustrator 10.x. The basic 
options this palette provides include the following:

• Rasterized Complex Regions shows areas that will be rasterized for performance reasons (as determined by the 
Raster/Vector Balance control). Stitching problems are more likely to occur along the boundary of the complexity 
regions (depending on the print driver settings and the Rasterization Resolution). Use the Clip Complex Regions 
option to minimize the possibility of such stitching problems when the Raster/Vector Balance control isn’t set to 
Vector (the rightmost position). 
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• Transparent Objects shows objects that are sources of transparency, including those to which non-normal 
blending modes, styles, and raster effects are applied, as defined on page 5. This option also highlights 
overprinting objects involved in transparency.

• All Affected Objects shows all objects that are involved in transparency.

• Affected Linked EPS Files shows of all placed-linked EPS files that are involved in transparency and that need to 
be manually converted into place-embedded files to flatten correctly.

• Expanded Patterns shows all pattern fills that would be expanded because they are involved in transparency.

• Outlined Strokes shows all strokes that would convert to outlines because they are involved in transparency or 
because Convert All Strokes to Outlines is selected. 

• All Rasterized Regions shows all regions of the document that would be rasterized by the flattener. These include 
the complexity region, (previewed by the Rasterized Complex Regions preview option), as well as the rasterized 
atomic regions.

Note: This option is available only if Detailed Preview is selected in the palette flyout menu.

• Outlined Text shows all text that would be converted to outlines because it is involved in transparency or because 
the Convert All Text to Outlines option is selected. 

Note: This option is available only if Detailed Preview is selected in the palette flyout menu.

Flattening controls in InDesign 2.x

InDesign 2.x provides many of the same flattening controls as Illustrator 10.x. It also provides some additional 
controls for identifying spreads with transparency, improving display performance and defining flattener styles.

• To access the flattener Styles selection panel, choose Edit > Transparency Flattener Styles:

The flattener Styles selection panel lists currently loaded flattener 
styles—Adobe provides the three shown here—along with options 
for creating custom styles. Settings for the currently selected style are 
summarized on this panel also.

This panel provides access to predefined flattener styles. Use New and Edit to create and modify custom styles. 
From the Flattener Styles panel, you can also load flattener styles created by customers or save your own styles for 
distribution to other computers.

Note: You cannot modify the predefined styles. You can select one and click New to create a new Style based on the 
settings of the selected style.
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• To access custom flattener styles, choose Edit > Transparency Flattener Styles > New

The Transparency Flattener Style panel lets you define and edit flattener styles 
that are used when printing or exporting. Name the flattener style according 
o the expected workflow or output.

This panel provides access to the Raster/Vector Balance control, flattener options, Flattener Resolution, and Gradient 
Resolution, and it lets you define custom flattening styles. New styles use the settings of the currently selected style 
as a starting place.

Flattener styles are used when printing or exporting from InDesign.

• To make use of an existing flattener Style, choose File > Print or File > Export, and click Advanced:

The flattener Style option of the 
Print and Export dialog boxes.

You can apply a flattener style to a document when it is printed or exported. A pull-down menu in either the Print 
or Export dialog box lets you select the appropriate style. A checkbox also lets you temporarily disable any spread 
flattening overrides applied via the Pages palette.

• To access the Spread Flattening Overrides option, choose Spread Flattening from the flyout menu on the 
Pages Palette:

Pages palette showing how to access spread flattening overrides via the flyout menu. 
Be sure to select the spread and then choose spread flattening options.
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You may want to flatten one or more spreads in a larger document using a different style than the rest. A separate 
flattening style can be applied to specific spreads of an InDesign 2.x file. An example is if a placed Illustrator graphic 
contains a very complex piece of transparent artwork or a transparent gradient with many small steps. By applying 
a style that specifies a lower Raster/Vector Balance setting to such a spread, you can reduce flattening time and 
memory requirements without affecting the quality of other spreads.

The control for applying, or subsequently removing, a spread flattening override is on the options flyout menu of 
the Pages palette. When you print or export a document, you can temporarily disable any spread flattening overrides 
via a checkbox on the Advanced panel of the Print and Export dialog boxes.

Transparency Display Performance in InDesign 2.x

• To access the Display Performance preferences, choose Edit > Preferences, and click Display Performance:

Note: The Display Performance preferences affect whether transparency is previewed on-screen.

The Display Performance preferences let you to change the way transparency in a document appears on-screen. 
It has no effect on transparency when it is printed. A slider lets you control the appearance of transparency in 
four gradations of quality, from fully simulated, allowing you to accurately position page items with drop shadows, 
for example, to completely disabled, allowing you to more quickly move page items and navigate spreads in a very 
large document.

Note that if transparency preview is completely disabled, you won’t be able to tell if objects in a page or spread have 
transparency or transparency-based effects applied to them. You can use the Pages palette for this purpose. As shown 
below, pages and spreads with transparency appear with a checkerboard pattern, and those with no transparency 
appear in white.

The InDesign Pages palette shows pages or spreads that have 
objects with transparency applied using a checkerboard pattern,
the same as Photoshop’s tranparency checkerboard pattern.
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Controls in Acrobat 5.x

Acrobat 5.x supports the Adobe PDF 1.4 format, which retains live transparency for PDF files created directly from 
Illustrator 9.x, Illustrator 10.x, or InDesign 2.x10. However, Acrobat 5.x doesn’t provide the most recent improve-
ments in flattening controls as do Illustrator 10.x and InDesign 2.x. Moreover, the Rasterization Resolution is preset 
to 300 dpi, which may not be suitable for preparing files for higher resolution output devices. Instead, PDF 1.4 files 
can be placed into an InDesign 2.x file for flattening. 

In Acrobat 5.x, the Quality/Speed pop-up menu, similar to the Raster/Vector Balance control, is the primary control 
over how much of a document is rasterized. It provides five choices, where Lowest/Fastest is equivalent to the Raster 
(leftmost) setting of the Raster/Vector Balance control, and Highest/Slowest is equivalent to the Vector (rightmost) 
setting of the Raster/Vector Balance control.

• To access the Quality/Speed pop-up menu, choose File > Print, and click Advanced:

To choose the flattener settings for PDF 1.4 files, use the Quality/Speed pop-up 
menu in Print Settings dialog box.

Controls in Photoshop

Photoshop doesn’t have transparency flattening controls, as found in other Adobe products. Instead, it automatically 
flattens and rasterizes all transparency at a document’s current resolution and adds a transparency mask upon export 
to retain any alpha channel information. Most applications that can accept file formats with transparency masks 
(such as TIFF and PDF 1.4) can use this transparency information.

Note: Illustrator 10.x and InDesign 2.x let you place native Photoshop files directly; however, all layers are effectively 
flattened, any remaining transparency is reduced to a single alpha channel.

10. Transparency from Photoshop is preserved when saved as Adobe PDF 1.4, but as a single alpha channel. 
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Section 3:Troubleshooting Transparency

Section overview
This section describes what you can to do to minimize or prevent problems in standard print production workflows. 
Each problem has corresponding descriptions and solutions. Note also the file format chart and list of RIP specific 
issues at the end of this section describing the capabilities of the various file formats in relationship to transparency 
and printing.

Following is a compilation of known issues, workarounds and recommendations for InDesign 2.x, Illustrator 10.x 
and Acrobat 5.x that relate to transparency and printing. This information is being provided to help ensure the 
successful output of your files for print production. Adobe continues to test and improve its software, however, there 
are situations where printing problems arise. Typically, and unless indicated, this information applies to using the 
software on both Macintosh and Windows operating systems.

Best Practices:

• Install and use the latest Adobe software updates

• Install and use the latest RIP software updates

• Install and use the latest PPDs/printer drivers

• Dedicate sufficient RAM to all applications

• Read the Print Service Provider Toolkit

• Read the ReadMe.pdf files which accompany the installers for additional known issues, resolved issues and 
production and troubleshooting tips.

Transparency-related issues to watch for 
Despite your best efforts to eliminate transparency issues, some may still arise. Typical issues to be concerned about 
include the following, in order of likelihood of occurrence:

1 Spot colors may convert to process when transparency is applied to spots.

2 Overprinting instructions may not be preserved.

3 Vector objects may get rasterized at too low of a resolution.

4 Stitching or artifacts may appear between atomic regions (areas that are flattened).

5 Type may get merged into (“baked into”) low-resolution images.

6 Hairlines and strokes may fatten (generally only a problem on lower resolution output devices).

7 Type may be converted to filled strokes (that is, it may thicken).
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8 Unexpected or missing plates may occur when you print color separations.

Some additional transparency interactions currently have no workarounds for optimal printing. Future versions of 
Adobe applications will likely address some of these interactions. Until then, however, be alert for the following 
elements when they are mixed with transparency:

• Preseparated content (DCS files)

• Duotone, tritone, or quadtone images place-linked into Illustrator files

• Images to be replaced after flattening occurs (for example, in workflows using an OPI server)

Go with your own flow

The degree to which the effects of flattening affect your work often depends on whether the flattened results are 
appropriate for the next step of your workflow. 

For instance, type that gets converted to outlines cannot be changed with a PDF touch-up tool. If a file is to be 
immediately color separated for printed output, and the flattener was set correctly, this issue is unlikely to occur. At 
other points in the workflow, however, it may cause a problem. Similarly, you may not be able to map one spot color 
to another color after flattening, but if the next workflow step is trapping, you may not need to map colors. 

The goal of quality print output is to maximize the value of transparency and minimize the effects of the transfor-
mation to a flattened file. 

TREAT FLATTENING LIKE PRESEPARATED CONTENT 

You may want to think about workflows involving flattened art in the same way as those that involve preseparated content—
something with which you are already familiar. 

With preseparated files, corrections can be made only by going back to a composite format. You cannot convert a spot color to process, 
fix a trap, change image resolution, or replace an image after separations are done. Similarly, flattening binds artwork into a represen-
tation that precludes making certain changes unless you return to the original version.

For similar reasons, you should use file formats that preserve transparency without flattening--or those that can be reflattened--
wherever possible. These file formats include the following:

- Illustrator 10.x native (transparency preserved)

- Illustrator 10 EPS (transparency can be reflattened in Illustrator 10.x)

- InDesign 2.x native (transparency preserved)

- PDF 1.4 from Illustrator 10.x or InDesign 2.x (transparency preserved).
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About these solutions 

You are unlikely to encounter significant problems if you follow the recommendations in Sections 1 and 2. However, 
if a file requires special attention, you may find a solution here. The following diagram illustrates the conventions 
used in this section to present the problems and solutions.

How the solutions are organized and presented.
A. Related Problems are organized by the Workflow Step at which they typically occur during prepress.
B. Each Workflow Step lists specific Common Scenarios in which the Problem can be encountered. 
C. The Effects of Flattening explains how flattening can influence the expected output.
D. Each Problem statement has its own subsection. 
E. Each Problem lists the relevant applications. 
F. “What is happening” gives a behind-the-scenes look at the flattening or printing process.
G. Each Problem has one or more specific Reasons. Solutions are presented to correspond to each Reason.

The following table summarizes the Workflow Steps in this section, the most common Problems, and 
potential Solutions. 

Note: This section covers some of the most important and common transparency workflow problems and solutions. 
Some of these problems will be addressed directly in future releases of Adobe applications. You may also encounter 
problems that have not yet been reported. If a problem isn’t covered here, look for an update to this guide on Adobe’s 
Web site, or contact Adobe Technical Support for further assistance. Support information is available on Adobe’s Web 
site at http://www.adobe.com/support/main.html.
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Workflow Steps that can be affected by transparency

Workflow Step Problems Potential Solutions

3.1 Printing color separations

3.1.1 • Spot colors convert to process. See page 39.

3.1.2 • Overprinting instructions are lost. See page 40.

3.1.3 • Unexpected plates are created when separations are generated. See page 41.

3.1.4 • Black overprinting specified with a proprietary printing system 
doesn’t work.

See page 42.

3.1.5 • Type converts to outlines after you flatten objects via the Flatten 
Transparency command in an Illustrator file.

See page 42.

3.1.6 • Spot colors, blending modes and Overprint Preview See page 43.

3.2 Proofing (onscreen and printed)

3.2.1 • A composite printer or proofing system with special support for 
spot colors behaves unexpectedly.

See page 44.

3.2.2 • The composite proof and on-screen preview of overprinting 
from Illustrator don’t match.

See page 44.

3.2.3 • PDF file exported from Illustrator or InDesign doesn’t show over-
printing when viewed in Acrobat.

See page 45.

3.2.4 • The on-screen appearance of a flattened file shows small white 
lines in a design that is actually seamless.

See page 45.

3.2.5 • Flattening a file takes an excessively long time, and the flattener 
may have eventually run out of memory.

See page 46.

3.2.6 • Feathered text that spans two pages in a spread doesn’t appear 
on the second page of an exported PDF file.

See page 47.

3.2.7 • Drop shadows may shift position, break up, or both. See page 47.

3.2.8 • Drop shadows wider than 16,000 pixels cause InDesign to crash. See page 47.

3.3 Graphics and images

3.3.1 • EPS graphics or images placed into Illustrator don’t interact with 
transparent artwork when printed or exported.

See page 49.

3.3.2 • Links in a native Illustrator file don’t appear after you place the 
file into InDesign.

See page 50.

3.3.3 • Placed EPS graphics print poorly. See page 50.

3.3.4 • A white box appears around the artwork in a placed EPS file, and 
it covers other objects in the layout.

See page 51.

3.3.5 • Type appears jaggy, at low resolution, and/or possibly shows 
stitching problems when printing.

See page 51.

3.3.6 • Effects applied to objects in an Illustrator file are coarse and visu-
ally unacceptable.

See page 52.

3.3.7 • A native Illustrator file placed in a page layout application that 
does not support transparency produces unexpected results on-
screen and in print.

See page 52.
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3.3.8 • DCS files placed into Illustrator or InDesign don’t print as part of 
a transparency.

See page 53.

3.3.9 • Duotones, tritones, and quadtones placed into Illustrator art-
work don’t print as part of a transparency.

See page 54.

3.3.10 • A PDF 1.3 file created using Illustrator or InDesign prints poorly. 
For example, resolution artifacts or color stitching occur.

See page 55.

3.3.11 • A placed PDF 1.4 file fails to place, print, or separate. See page 56.

3.3.12 • Unable to place a native Illustrator 10.x file in InDesign. See page 57.

3.3.13 • Transparency effects do not display correctly when viewed 
in Acrobat 4.0.x

See page 57.

3.3.14 • A placed PDF 1.3 file has lost spot colors and text and prints 
poorly (resolution artifacts or color stitching).

See page 57.

3.3.15 • Objects with transparency view differently when exported to 
PDF 1.3 vs. 1.4

See page 58.

3.4 Image replacement

3.4.1 • Transparency effects are poor or lost after image replacement. See page 59.

3.4.2 • The low-resolution or proxy version of an image prints after OPI. See page 59.

3.4.3 • OPI and Simulate Overprint See page 59.

3.5 Color conversions

3.5.1 • The output device cannot reproduce some colors in a flattened 
document. 

See page 60.

3.5.2 • The colors are unacceptable in a placed file that interacts with 
transparency.

See page 61.

3.5.3 • Colors are jaggy and irregular (that is, color stitching occurs) in a 
flattened file.

See page 61.

3.5.4 • Remapping spot colors is impossible or gives unexpected results 
after flattening a file.

See page 63.

3.5.5 • All spot colors convert to process colors after flattening objects 
via the Flatten Transparency command in an Illustrator file.

See page 63.

3.5.6 • The wrong spot colors appear in an InDesign document 
after flattening.

See page 64.

3.6 Trapping

3.6.1 • Flattened files are trapped incorrectly See page 64.

3.6.2 • Opaque objects touching objects with transparency 
effect trapping

See page 65.

Workflow Step Problems Potential Solutions
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Section 3.1: Printing separations

Common scenarios

Printing host-based color separations

Printing in-RIP color separations

Trapping in-RIP

The effects of flattening

Host-based separations (such as those from Adobe Illustrator, Adobe InDesign or QuarkXPress™) and in-RIP 
separations both require that transparent artwork be flattened before color separations are made. Here’s how that 
flattening usually occurs:

• If artwork is in native Illustrator 10.x format, flattening occurs when you print separations from Illustrator. Or, 
if the artwork is placed in InDesign 2.x, it occurs when you print separations from InDesign. QuarkXPress doesn’t 
properly flatten native Illustrator 10.x artwork that contains transparency.

• If artwork is exported from Illustrator 10.x to EPS for placement in another separation application, flattening 
occurs in Illustrator 10.x. Illustrator can still open this EPS and edit live transparency, however, the EPS is 
considered as flattened when placed into InDesign.

3.7 Flattening

3.7.1 • Strokes thicken after flattening See page 65.

3.7.2 • Artifacts appear onscreen after flattening See page 65.

3.7.3 •  The output device cannot reproduce some colors in the flat-
tened document because inappropriate color space was used 
when flattening.

See page 66.

3.8 RIP specific information

3.8.1 • PDF 1.4 and Apogee PDF RIP See page 66.

3.8.2 • Creo/Scitex Brisque 3.0, 4.0 setting for processing files 
with transparency

See page 66.

3.8.3 • Creo Brisque 3.0 and 4.0, user must flatten PDF 1.4 files prior
to RIPing

See page 67.

3.8.4 • Creo Prinergy 2.0 and earlier and spot colors See page 67.

3.8.5 • Creo PS/M 7.0 See page 67.

3.8.6 • Harlequin RIP v 5.3 r4 handles AI 10 with transparency See page 67.

3.8.7 • Heidelberg MetaDimension overprint not retained See page 67.

3.8.8 • Heidelberg Prinergy 2.0 and earlier and spot colors See page 67.

3.8.9 • Rampage information See page 68.

Input/Ouput file formats • Comparison of input and output file formats and their 
capabilities for transparency, spot color, and overprint.

Workflow Step Problems Potential Solutions
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• If spreads are in native InDesign 2.x format, flattening occurs when you print separations from InDesign. 
InDesign 2.x properly flattens native Illustrator 10.x and PDF 1.4 documents containing transparency.

Note: Flattening of placed native Illustrator 10.x artwork is performed using the flattening parameters of InDesign, 
not those that were associated with the artwork in Illustrator.

• If spreads are exported from InDesign 2.x to EPS, flattening occurs in InDesign.

• If any file is printed to PostScript for in-RIP separations, flattening occurs wherever the file is first converted to 
a non-native format in the workflow. 

Also note that flattening (or certain flattened file formats) can affect separations by changing spot colors to process, 
pre-processing and removing overprinting instructions, or altering which plates are produced. These issues are 
discussed later in this section of the guide.

Problem 3.1.1: Spot colors convert to process. 

Relevant products

Illustrator 10.x, InDesign 2.x

What is happening

The application that flattens the file preserves only spot colors when writing certain file formats, or the incorrect 
options were selected prior to flattening. In addition, spot colors always convert to process equivalents as a side effect 
of using certain Illustrator filters or raster effects (such as Gaussian Blur), which require rasterization before 
flattening.

Reason: Artwork created in Illustrator wasn’t saved as Illustrator 10 EPS. This format is the only one in which 
Illustrator 10.x preserves spot colors during flattening.

Solution: Obtain the original Illustrator 9 or 10 file, and save it as Illustrator 10 EPS. 

Another solution, if you use InDesign 2.x for page layout, is to place the unflattened native Illustrator 10.x file or an 
exported PDF 1.4 rendition of the file directly in the layout. In either case, transparency remains live and unflattened 
and spot colors are preserved.

Note: Even if saved to Illustrator 10 EPS, some spot colors may still convert to process because there is no other way to 
represent the requested effect. See additional Reasons and Solutions below.

Reason: Spreads created in InDesign 2.x were saved as PDF 1.3 (Acrobat 4) with Simulate Overprinting selected on 
the Advanced panel of the Export dialog box.

Solution: Obtain the original InDesign 2.x spread (along with all relevant fonts and placed files), open it in InDesign 
2.x, and save it as PDF 1.4 (Acrobat 5) or EPS with Simulate Overprinting deselected. Or, save as PDF 1.4 (Acrobat 
5) or as EPS.

Reason: Artwork was saved as Adobe PDF 1.3 directly from Illustrator 10.x (instead of using Adobe Acrobat 
Distiller). Illustrator 10.x doesn’t preserve spot colors when flattening transparency into PDF 1.3 directly.

Solution: Obtain the original Illustrator 10.x file, create a PDF 1.3 file by first saving the original file as an Illustrator 
10 EPS or PostScript file, and then use Acrobat Distiller to create a PDF 1.3 file. 
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Another solution, if you use InDesign 2.x for page layout, is to place the unflattened native Illustrator 10.x file or an 
exported PDF 1.4 rendition of the file directly in the layout. In either case, transparency remains live and unflattened, 
and spot colors are preserved.

Reason: An Illustrator 10.x filter or raster effect (such as a Gaussian Blur), which doesn’t preserve spot colors, was 
applied to one or more spot colored objects.

Solution: Reproduce the effect in Adobe Photoshop, if possible, to preserve spot colors. Then save the file as EPS, 
and incorporate it into the design during page layout. However, see “Problem 3.3.9: Duotones, tritones, and 
quadtones placed into Illustrator artwork don’t print as part of a transparency.” on page 54 for related problems.

Reason: Artwork created in Illustrator 10.x uses a gradient or a mesh object that involves one or more spot colors 
and process color stops. Illustrator always converts spot colors in gradients to the process equivalents when the other 
stop color is process. Spot to spot gradients will not be converted to process.

Solution: Convert the process stop color into a spot swatch.

Problem 3.1.2: Overprinting instructions are lost. 

Relevant products 

Illustrator 10.x, InDesign 2.x

What is happening

Overprinting instructions may be preprocessed along with transparency as a side effect of flattening. (The conditions 
are described in Section 1.) In many cases, the results of this preprocessing may be the same as the results of 
processing the instructions by a PostScript RIP. Results may vary, however, depending on which application you use 
to flatten transparency. You may need to adjust your workflow to preserve overprinting and achieve the effects 
required to print a document correctly.

Overprinting instructions may not survive flattening for three possible reasons:

• The application that flattens the file preserves overprinting only when writing certain file formats.

• Native overprint cannot be preserved and must be flattened for objects involved in transparency (as defined on 
page 5). All of these reasons apply if the file contains both transparency and overprinting. Files that contain only 
overprinting aren’t flattened and retain overprinting instructions.

Exception: Composite printing from Illustrator 10 — it can either ignore or flatten overprint, but cannot preserve 
the native overprint instructions.

Reason: Artwork created in Illustrator 9.x or 10.x contained both transparency and overprinting, and it wasn’t saved 
as Illustrator 10 EPS. EPS is the only format in which Illustrator 10.x preserves overprinting during flattening.

Solution: Obtain the original Illustrator 9.x or 10.x file, and save it as unflattened PDF 1.4 or Illustrator 10 EPS. 
Be sure to check Preserve Overprints When Possible on the Transparency panel.

Reason: Artwork created in Illustrator 9.x or 10.x contained both transparency and overprinting, and it was saved 
as Illustrator 10 EPS, but Preserve Overprints When Possible wasn’t checked on the Transparency panel.

Solution: Open the EPS file using Illustrator 10.x, check Preserve Overprints When Possible on the Transparency 
panel, and resave the document.
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Reason: A spread created in InDesign 2.x was exported as EPS or Adobe PDF 1.3 with Simulate Overprinting 
selected.

Solution: Obtain the original InDesign 2.x spread (along with all relevant fonts and placed files), open it in InDesign 
2.x, and save it as EPS or PDF 1.3, making sure Simulate Overprinting is NOT checked in the Advanced panel of the 
Export dialog box.

Reason: Objects to which overprinting is involved interact with transparency in a way that requires preprocessing 
by the flattener. If the flattened file is placed over objects in another design or page layout, the expected overprinting 
effects aren’t achieved.

Solution: If you use InDesign 2.x for page layout, obtain the unflattened native Illustrator 10.x file or an exported 
PDF 1.4 rendition of the file, and place it directly in the layout. When InDesign 2.x flattens the placed file, the 
overprinting instructions are correctly preprocessed to obtain the desired overprinting effects.

Notes on Overprint Preview: 

Use Overprint Preview for the most accurate onscreen preview of print output. Be sure to consider the following:

When in RGB Transparency Blend Space (InDesign) or RGB Document Color Mode (Illustrator), on-screen 
Overprint Preview will only simulate Spot ink overprints. Process ink overprints will not be simulated to screen, 
though they will be simulated if the user selects the Overprint Simulation option in the Print or PDF Export dialog 
boxes. Note that using a transparency blending space that differs from the output space may cause color shifts in the 
resulting output. [453586]

Overprint Preview is not correctly displayed in InDesign if a document containing a gradient object on top of 
a process color object is exported to PDF as Acrobat 5.0 compatible then placed in a new InDesign document. 
[476932]

If a Freehand EPS file containing a ‘spot-to-spot’ color gradient is placed in a document, and Overprint Preview is 
enabled on the View menu, and/or the document is printed with Simulate Overprint enabled in the Output panel of 
the Print dialog box, solid areas may appear in the gradient. Disabling the Overprint Preview and/or the Simulate 
Overprint option should resolve this issue. [490731]

When using Overprint Preview mode to display page items with CMYK color swatches applied, the Transparency 
Blend Space should be set to Document CMYK. The Transparency Blend Space can be changed from the Edit Menu. 
If the Transparency Blend Space is set to Document RGB, overprinting of CMYK colors will not be displayed in 
Overprint Preview mode. [453586]

Problem 3.1.3: Unexpected plates are created when separations are generated.

Relevant products 

Illustrator 10.x, InDesign 2.x

What is happening

If certain blending modes are applied overlapping objects, the effects created may change the process inks needed to 
reproduce a design—possibly introducing inks the designer didn’t specify. For example, if a document that uses only 
cyan and black process inks includes objects to which the Difference blending mode is applied, the result introduces 
magenta and yellow process inks. When the document is separated, four rather than two plates are created.
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Reason: The file uses a blending mode: Difference, Exclusion, Hue, Color, Saturation, or Luminosity. 

Solution: Creating or removing a process color plate is a side effect of using these blending modes. Aside from 
consulting with the designer, no workaround is available for this problem. These blending modes, by design, may 
generate ink on all process plates. Do not use these blend modes if you do not output on all process plates.

Problem 3.1.4: Black overprinting specified with a proprietary printing system doesn’t work.

Relevant products

Illustrator 10.x, InDesign 2.x

What is happening

This problem may occur for three reasons:

• The application that flattened the file preserves overprinting only when writing to certain file formats.

• Application-specific options that control how overprinting instructions are interpreted during export were set 
incorrectly.

• Some or all of the type in a document was converted to outlines or was partially or completely rasterized. Propri-
etary systems that include options to set black type to overprint are therefore unable to recognize the type as type, 
so these options don’t work. As a result, the converted type knocks out whatever it is placed over in the final design.

Solutions for the first two reasons are listed under “Overprinting instructions are lost.” Solutions for the third reason 
include the following: 

Reason: The Raster/Vector Balance setting is too low or the incorrect flattener option is selected.

Solution: Open the original file in its native application, make sure that Raster/Vector Balance is set to the highest 
fidelity (rightmost position), and make sure that Convert All Text to Outlines is deselected. Black type overprinting 
should be applied BEFORE flattening if at all possible. Then resave the file in an appropriate format (one that 
preserves overprinting), and overprint the black type again.

InDesign 2.x uses special flattener styles to record and reuse flattener settings more easily. The High Resolution style 
provides the best results for most output devices. You should also review any local flattener settings that were applied 
to spreads in the InDesign 2.x file. You may need to adjust or disable these settings, as appropriate. See “Flattening 
controls in InDesign 2.x” on page 28.

Reason: Type may be converted to outlines because of its interaction with gradients, images, spot colors, or because 
of a style applied to it.

Solution: .No workaround is currently available for this problem.

Problem 3.1.5: Type converts to outlines after you flatten objects via the Flatten Transparency 
command in an Illustrator file.

Relevant products

Illustrator 10.x

What is happening

Illustrator 10.x allows you to select one or more objects in a design, and then manually flatten them using the 
Object > Flatten Transparency command. This feature can be used to work around other transparency-related 
problems. However, because it doesn’t always provide the same results as flattening on export or printing, it must 
be used carefully.



43
Troubleshooting Transparency

Reason: Type always converts to outlines when it is flattened via the Flatten Transparency command in Illustrator 
10.x, and it can no longer be edited as type.

Solution: Defer flattening to the print/export stage.

Problem 3.1.6: Spot colors, blending modes and Overprint Preview

When using spots colors and the following blend modes — Hue, Saturation, Luminosity, Color, Difference and 
Exclusion — make sure that Overprint Preview (OPP) is enabled in InDesign. When OPP is disabled, InDesign/
Illustrator/Acrobat use the CMYK definition of the spot color to produce the on-screen representation. 
However, when OPP is enabled, InDesign/Illustrator/Acrobat preserves the fact that the spot color will separate 
on its own plate. Since the above blend modes have little if any meaning with spot colors, the results are different 
than when viewed with OPP disabled. Note that the results via Overprint Preview are the results that will be obtained 
making separations.

Section 3.2: Proofing

Common scenarios

Creating composite desktop proofs

Creating composite digital contract proofs

Creating separation film-based digital contract proofs

Making soft proofs

Performance issues related to transparency and flattening

The effects of flattening

Flattening has several side effects on proofing.

First, when spot colors are involved in transparency of any sort (for example, opacity change or use of blending 
modes other than normal), the correlation diminishes between a composite proof and the final printed piece. 
You should make the designer who uses spot colors and transparency together aware of this fact.

Second, some composite printing/proofing systems can improve the normal simulation of spot colors by using 
additional inks or colorants to extend the CMYK gamut. Many composite proofing devices rely on proprietary color 
conversion methods to convert custom spot colors into a color range or gamut that the proofing device can 
reproduce. The composite proof created on such devices usually matches on-press results better.

For either simulation system to work, the device’s PostScript interpreter must be able to read the spot color names 
from the print stream. However, if flattening has converted spot colors to process color equivalents first, the spot 
color names and color values are stripped from the print stream, and the device’s color engine cannot perform the 
proper optimization or transformation. Therefore, the results of a composite simulation may not be as good as those 
normally achieved with these special classes of composite printers. 

Note: Spots cannot be converted to process after flattening.

A related issue involves soft proofing documents. Illustrator 10.x, InDesign 2.x, and Adobe Acrobat 5.x can be 
configured to simulate overprinting both on-screen and when a document is printed to a composite printer. 
For documents that contain transparency and overprinting, these applications must be configured correctly to 
ensure the most consistent soft-proofing.
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Problem 3.2.1: A composite printer or proofing system with special support for spot colors 
produces unexpected results.

Relevant products

Illustrator 10.x, InDesign 2.x, Acrobat 5.x

What is happening

As was discussed earlier (see “Section 3.1: Printing separations” on page 38), the application that flattens the file 
preserves spot colors only when writing certain file formats and when the correct options are selected prior to 
flattening. If spot colors convert to process colors during flattening, the names of the spot colors aren’t present in the 
resulting file or print stream. Consequently, composite proofing systems that provide special spot color simulations 
behave unexpectedly.

Another possibility is that spot colors were converted to process because they are part of a transparency-based effect 
that could be represented only with process colors.

Reason: Artwork created in Illustrator wasn’t saved as Illustrator 10 EPS, the only format in which Illustrator 10.x 
preserves spot colors during flattening.

Solution: Obtain the original Illustrator 9 or 10.x file, and save it as Illustrator 10 EPS.

Reason: An option that controls overprinting when a file is printed or exported is configured incorrectly.

Solution: Open the native file, and review the options that control overprinting during flattening or printing. 
You may need to disable these options as appropriate. Relevant flattening options are described under “Overprinting 
is Not Preserved” in Section 2. Application-specific printing options, such as those provided by Illustrator 10.x, 
are described in the application’s on-line documentation.

Note: These options are provided as a means of proofing overprinting on lower-end composite devices otherwise 
incapable of such simulations on their own.

Reason: Spot colors were preserved in the exported file, but the printing device used the composite (non-separable) 
representation.

Solution: Although no workaround is available for this problem, the spot colors are preserved when the file is 
separated if separations are made from the native file or a file format that preserves spot colors: Illustrator 10 EPS, 
InDesign 2.x EPS, or Adobe PDF 1.4. See notes under “Section 3.3: Graphics and images” on page 48 for more details.

Problem 3.2.2: The composite proof and on-screen preview of overprinting from Illustrator 
don’t match.

Relevant products

Illustrator 10.x

What is happening

Overprinting instructions that the flattener would normally process before printing a file are ignored because 
of options set in the Print dialog box. 

Reason: This problem occurs when printing composites from Illustrator 10.x if Ignore Overprinting in
Composite Output is enabled on the Illustrator panel in the Print dialog box.

Solution: Make a new composite proof from Illustrator 10.x with Ignore Overprinting in Composite 
Output disabled.
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Problem 3.2.3: PDF file exported from Illustrator or InDesign doesn’t show overprinting when 
viewed in Acrobat.

Relevant products

Illustrator 10.x, Acrobat 5.x, Acrobat 4.x

What is happening

By default, Acrobat 5.x—which supports overprint preview—isn’t configured to present this preview for 
performance reasons. 

Reason: Acrobat 4.x doesn’t support overprinting preview.

Solution: Upgrade to Acrobat 5.x, which supports overprinting preview.

Reason: Acrobat 5.x isn’t configured to preview overprinting.

Solution: Enable preview overprinting in Acrobat 5.x from the View menu. Note that this option can impact the 
performance of Acrobat 5.x.

Problem 3.2.4: A placed EPS file printed as a composite proof doesn’t show overprinting.

Relevant products

QuarkXPress, InDesign 1.x.

What is happening

The receiving application interprets the EPS in a way that ignores the precalculated overprinting preview color 
information in the file. Instead, the application uses the file’s embedded color-separations information for printing 
the composite. Nothing is wrong with the exported EPS, and it will separate correctly. Only the preview and the 
composite proof are affected.

Reason: The receiving application cannot read the EPS file’s overprinting preview information. 

Solution: In effect, you can ignore the problem, since the file will separate correctly. Upgrading from InDesign 1.x 
to 2.x, however, will solve the composite preview problem.

Problem 3.2.4: The on-screen appearance of a flattened file shows small white seams 
between objects.

Relevant products

Illustrator 10.x, InDesign 2.x, Acrobat 5.x.

What is happening

Flattening results in breaking up objects into small abutting pieces. The antialiasing algorithm used to preview 
the document onscreen is fast but has a side effect of showing white seams along abutting objects. Typically these 
artifacts do not appear in high resolution print output. If artifacts or stitching appears in printed output, check your 
flattener settings aas previously described.
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Reason: Antialiasing is enabled for screen preview.

To improve application performance, the code used to render a file to the screen may only approximate the dimen-
sions of objects that otherwise fit tightly against one another.

Solution: You can ignore these artifacts, as they won’t appear at the higher resolutions associated with desktop 
printers and high-resolution output devices.

Workarounds: (may not work for highly complex graphics or very transparent backgrounds) Either flatten with 
Highest Quality setting (towards Vector) and/or select Clip complex regions.

Problem 3.2.5: Flattening a file takes an excessively long time and/or requires too much memory

Relevant products

Illustrator 10.x, InDesign 2.x

What is happening

Flattening can be both time and memory intensive, especially when a very complex design or large document 
is flattened at the highest fidelity (rightmost setting) of the Raster/Vector Balance control. In some extreme 
cases, flattening may even run out of memory and fail to complete. However, some steps can help you address 
these problems.

Reason: Spreads in an InDesign 2.x document contain objects that require excessive amounts of time or memory 
to flatten.

Solution: Use an alternative flattener style for the affected pages. To specify a spread flattening override, first select 
the affected spread from the Pages palette, and then use the options fly-out to access the Spread Flattening menu. 
Any existing flattener style can be used for the override, but you can design a custom style especially for this purpose.

After you apply a spread flattening override, you can cause it to be ignored when a document is printed or exported 
by selecting the checkbox for this purpose on the Advanced panel of the Print and Export dialog boxes.

Reason: The Raster/Vector Balance control is set to the highest fidelity (rightmost position).

Solution: Lower the Raster/Vector Balance control. While this solution can reduce the time and memory required 
for flattening, it can also lower the quality of the flattened file.

Note: Generally, Adobe recommends using the highest fidelity setting to minimize the conversion of vector and type 
objects to raster or outlines. Before you experiment with flattener settings, read Section 3, which provides details about 
the flattening process.

In Illustrator 10.x, you can use the Flattening Preview palette to gauge the effect of any changes to the Raster/Vector 
Balance control before flattening the file. You should also be sure use to observe the effect of disabling the Clip 
Complex Regions option. 

InDesign 2.x has no Flattening Preview, so changes to the Raster/Vector Balance control can be inferred only by 
observing the appearance of a proof and by experience with transparency over time. 
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Problem 3.2.6: Feathered text that spans two pages in a spread doesn’t appear on the second 
page of an exported PDF file.

Relevant products

InDesign 2.x

What is happening

The InDesign 2.0 code that creates PDF files doesn’t generate the correct drawing instructions for the portion of the 
text that appears on the second page. 

Reason: This problem is a bug in InDesign 2.0.

Solution: Install the free InDesign 2.01 update, which you can download from Adobe’s Web site.

Problem 3.2.7: Drop shadows may shift position, break up, or both.

Relevant products

InDesign 2.x

What is happening

The InDesign 2.0 code that processes the drop shadow effect doesn’t manage memory correctly. 

Reason: This problem is a bug in InDesign 2.0. 

Solution: Install the free InDesign 2.01 update, which you can download from Adobe’s Web site.

Problem 3.2.8: Drop shadows wider than 16,000 pixels cause InDesign to crash.

Relevant products

InDesign 2.x

What is happening

The InDesign 2.0 code that processes the drop shadow effect doesn’t manage memory correctly. 

Reason: This problem is a bug in InDesign 2.0. 

Solution: Install the free InDesign 2.01 update, which you can downloaded from Adobe’s Web site.
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Section 3.3: Graphics and images

Common scenarios

Placed graphics or images used as part of transparent art in Illustrator 10.x

Placed graphics or images used as part of a transparent design in InDesign 2.x

EPS, native Illustrator 10.x, and DCS/multi-tone graphics placed into other applications

Placed PDF 1.3 files

Placed PDF 1.4 files

The effects of flattening

Several circumstances can create flattener-related issues with placed graphics and images. These issues arise whether 
the placed file interacts with transparency applied to objects over or under it, or if the placed file contains live 
transparency (such as a native Illustrator 10.x file placed in an InDesign 2.x spread). In this case the placed file may 
need to be embedded rather than simply linked to achieve the desired results.

Transparency related-issues can also occur if a graphic or image that contains transparency is saved as EPS for 
placement into an application that cannot interpret transparency (such as InDesign 1.5 or QuarkXPress). For 
example, if an EPS file is saved from Illustrator to be compatible with an earlier version (such as Illustrator 8) or with 
PostScript Level 1, flattening changes spot colors to process, can remove overprinting instructions, and can alter 
which plates are produced. It may also produce poor-quality output, such as shifts in resolution or color stitching.

Note: Illustrator10 EPS files contain an EPS (PostScript) portion and a native Illustrator portion. When an Illustrator 
10 EPS file is placed in any application other than Illustrator 10.x, only the EPS portion is used. Which Illustrator 
version you prefer to work with determines your control over flattening. If you request Illustrator 8 EPS files—which 
can be flattened only once when they are created—instruct your customers to adjust the Raster/Vector Balance control 
and resolution settings to suit your needs. You can’t adjust these settings after the file is saved as Illustrator 8 EPS (unless 
you have access to the original Illustrator 10.x file and can resave it). If you request Illustrator 10 EPS files, you can 
always reopen them, adjust flattener values, and resave them as required.

Note: Illustrator 10 and InDesign 2 EPS files are encoded with two different PostScript descriptions of the colors used. 
One description is optimized for separations, in which spot colors are retained but flattened (that is., the plates cannot 
be changed). Another description is provided for composite output, in which overprinting is simulated and spot colors 
are converted to process to match what is on screen. Additional PostScript logic built into the file automatically 
determines which description—separations or composite—to use when the EPS file is RIPed. This logic is robust 
and correctly recognizes “composite separation” devices, such as Extreme and PostScript 3 RIPs, and chooses the color 
description that is suitable for making separations. High-end composite proofing devices also correctly use the 
separations description. For more information, see “Section 3.4: Performing image replacement” on page 58. 
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Problem 3.3.1: EPS graphics or images placed into Illustrator don’t interact with transparent 
artwork when printed or exported.

Relevant products

Illustrator 10.x

What is happening

Illustrator 10.x supports two types of placed files: linked and embedded. EPS graphics and images in placed-linked 
files that are involved in transparency (as defined on page 5) are not accessible during flattening and print as if they 
are in the bottom-most layer of the file. They appear as if they were placed underneath all other objects in the design. 

Note: By visually inspecting a document, you can’t always tell if a placed EPS file interacts with transparency. In 
Illustrator 10.x, the Flattening Preview palette lets you make this determination. The plug-in for this palette and 
instructions for using it are in the Utilities/Flattening Preview folder where you installed Illustrator 10.x. You can 
also use the "Show Transparency Information" checkbox in the links palette.

Reason: Placed-linked files can be flattened properly in Illustrator 10 only when they are not involved 
in transparency.

Solution: You can embed the placed file: Resave the Illustrator 10.x document by choosing Save As, and select 
Include Linked Files in the Save As dialog box. You can also manually change links to the embedded type by selecting 
the Embed Image option on the Links palette. If you use an EPS or PDF workflow, you also need to re-create the EPS 
or PDF file from the updated Illustrator file.

If this solution isn’t an option, change the drawing order (for example, move the file up to another layer) or 
reposition the placed file so it doesn’t interact with transparency, if you can do so and maintain the integrity of the 
design. You may need to work with the designer to ensure that the design isn’t compromised.

Note: If an EPS file is preseparated (such as DCS artwork) or a multi-toned image (such as duotone, tritone, or 
quadtone), it won’t place-embed in native Illustrator files. The solution above to embed an EPS file doesn’t work with 
these kinds of EPS files. If the source file for a linked DCS is available, it may be possible to resave it in a composite 
format that Illustrator 10.x can place-embed. See “Problem 3.3.8: DCS files placed into Illustrator or InDesign don’t 
print as part of a transparency.” on page 53 for details. If the file is a multi-toned image, and it must interact with 
transparency, consider using InDesign 2.x to solve the problem. InDesign provides more complete support for placing 
multi-toned images.

Additional information

If your customers’ files include only placeholder (low-resolution or proxy) images, and final color and artwork are 
being prepared elsewhere, you need to obtain the images and embed them (that is, fatten the Illustrator 10.x file) 
before flattening.

Illustrator 10.x doesn’t provide a warning when you attempt to link a graphic or image into a file that contains
transparency.
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Problem 3.3.2: Links in a native Illustrator file don’t appear after you place the file in InDesign.

Relevant products

Illustrator 10x, InDesign 2.x

What is happening

Although Illustrator 10.x supports two types of placed files: linked and embedded, InDesign 2.x works properly with 
Illustrator 10.x files only if they use placed-embedded links.

Note: This problem isn’t specific to transparency. 

Reason: When a file was first placed in Illustrator 10.x, the Link was selected in the Place dialog box. 

Solution: Resave the Illustrator 10.x file, making sure to select Include Links in the Save As dialog box. You can also 
manually convert a placed file by selecting Embed Image on the Links palette flyout menu.

Problem 3.3.3: Placed EPS graphics print poorly.

Relevant products

Illustrator 10.x, InDesign 2.x

What is happening

EPS files created with Illustrator 10.x or InDesign 2.x contain rasterized regions or color information that is inappro-
priate for the final output device, resulting in problems such as resolution and color stitching artifacts within the 
transparent areas.

Reason: The Raster/Vector Balance, Rasterization Resolution, and overprinting settings during EPS export weren’t 
optimized for the output device. 

Solution: If the EPS files was created with Illustrator 10.x, open it in Illustrator 10.x and make sure that the 
flattener’s Raster/Vector Balance is set to the highest fidelity (rightmost position). You may also want to increase 
the Rasterization Resolution if it seems excessively low. Also make sure that Preserve Overprints When Possible is 
selected in Document Setup. Then resave the file as EPS. 

If the EPS file was created using InDesign 2.x, open the native InDesign 2.x file, and reexport it as EPS, making sure 
to select High Resolution as the flattener style on the Advanced panel of the Export dialog box. Also be sure that 
Simulate Overprints is not selected. Then export a new EPS file.

Note: See “What are your points of control?” on page 17 for details on how to change all flattener settings.

Reason: Linked files are not accessible during flattening in Illustrator 10.x.

Solution: Obtain the original Illustrator 9x. or 10.x file, embed the graphics via the Links palette or Embed Image 
command, and either print the file from Illustrator 10.x or resave it as Illustrator 10 EPS for placement in another 
application. If you use InDesign 2.x you can also simply place the native Illustrator 10.x file directly. See “Problem 
3.3.1: EPS graphics or images placed into Illustrator don’t interact with transparent artwork when printed or 
exported.” on page 49 for additional recommendations.
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Problem 3.3.4: A white box appears around the artwork in a placed EPS file, and it covers other 
objects in the layout.

Relevant products

All applications that can place EPS files

What is happening

Certain areas in the document may get rasterized during flattening, depending on their complexity and the 
Raster/Vector slider level. The portions of the rasterized area that have no objects are rasterized in white. If the 
flattened document is subsequently placed in an aggregate application, those white areas will obstruct any objects 
in the background.

Reason: The rasterized areas in the flattened file obstruct objects in the background when the EPS file is placed in 
an aggregate application

Solution: Open the EPS file in Illustrator 10.x, and either set the Raster/Vector Balance control to the highest fidelity 
(rightmost position) or select Clip Complex Regions, and then resave the file. To preview the results immediately, 
use the Flattening Preview palette. See “Flattener options” on page 21 for details. 

Note: These settings may cause the flattener to take longer and use more memory.

Optionally, if you use InDesign 2.x as the page layout application, you can place the native (unflattened) file directly. 
The advantage of this solution is that the feathered edges of special effects like drop shadows will be blended correctly 
with any objects over which they fall.

Note: In Illustrator 9.x, you can’t avoid creating the matte during flattening. To correct the problem, reflatten files in 
Illustrator 10.x as described above, or place them into InDesign 2.x prior to flattening. In some cases, another solution 
is to reflattening the artwork in Illustrator 9.x using the highest Quality/Speed setting (level 5).

Problem 3.3.5: Type appears jaggy, at low resolution, and/or possibly shows stitching problems 
when printing.

Relevant products

Illustrator 10.x, InDesign 2.x, Acrobat 5.x

What is happening

A region of a transparent design is too complex for the given Raster/Vector Balance setting, so the flattener rasterizes 
everything within it. If any type straddles this kind of region, stitches (a resolution mismatch) may appear between 
the portions of type left unchanged and type that was rasterized. Usually, this problem is evident only in high-
resolution proofs and in the final output.

Reason: The setting for Raster/Vector Balance is too low (for example, significantly below the rightmost position).

Solution: Reflatten the file using the highest fidelity (rightmost position) for the Raster/Vector Balance control, and 
resave it. If the file is in Illustrator 10 EPS format, you can opened it in Illustrator10.x, and reflatten it directly. If the 
file is in another format (such as EPS created using InDesign 2.x or Adobe PDF 1.3 created using Distiller), then the 
native source file must be used to correct the problem. 
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Reason: Some Scitex RIPs may cause this problem - see the section on RIP known issues and solutions at the end of 
this section.

Solution: Increase the Rasterization Resolution (AI10) or the Flattening Resolution (ID10) to one appropriate for 
rasterizing the type.

In InDesign 2.x, you can use special flattener styles to record and reuse flattener settings more easily. The High 
Resolution style provides the best possible results for most output devices. You should also review any local flattener 
settings that may have been applied to spreads in the InDesign 2.x file. You may need to adjust or disable these 
settings, if appropriate. See “Flattening controls in InDesign 2.x” on page 28 for details.

Reason: The Raster/Vector Balance control is set to the highest fidelity, but type is still being rasterized.

Solution: In a few cases, rasterization is unavoidable. Be sure that the Rasterization Resolution (or Flattener 
Resolution in InDesign 2.x) is therefore set to a value that best reflects final output conditions.

Another reasonable solution may be to completely rasterize such a design. This solution is appropriate only if the 
design is relatively small (so the resulting file size isn’t an issue) and if the design isn’t incorporated into a page layout 
such that it overlaps with other page items (because they would be covered by the resulting raster image). 

To completely rasterize a design, set Raster/Vector Balance to the leftmost position before flattening. Also be sure that 
the Rasterization Resolution is set to match final output conditions. See “What resolution settings are correct?” on 
page 24 for details.

Problem 3.3.6: Effects applied to objects in an Illustrator file are coarse and visually unacceptable.

Relevant products

Illustrator 10.x

What is happening

Some effects available in Illustrator 10.x, such as Gaussian Blur, are represented using raster rather than vector data. 
The resolution chosen for these raster-based effects, controlled by the Raster Effects Resolution setting, must be suffi-
ciently high to ensure that the final output results are visually acceptable.

Reason: By default, Illustrator 10.x renders raster-based effects at 72 dpi, which is generally acceptable for output 
on-screen or on very low resolution printing devices. 

Solution: Increase the Raster Effects Resolution setting to higher than 72 dpi. For high-end output devices, a value 
between 150 and 300 dpi is more acceptable. Higher values may be used, but they increase the size of the resulting 
file, and the results may be indistinguishable from the results of a lower resolution.

Problem 3.3.7: A native Illustrator file placed placed in an application that doesn't support 
transparency produces unexpected results on-screen and in print.

Relevant products

InDesign 1.5, Illustrator 8, PageMaker, QuarkXPress
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What is happening

Through release 8.0, native Illustrator files are based on PostScript. These native files can therefore be parsed by any 
application that can read EPS. Starting with release 9.0, graphics in native Illustrator files are based on Adobe PDF 
1.4, not PostScript. If you try to place a native Illustrator 9.0 or later graphic into an application that doesn’t under-
stand PDF 1.4, your may receive undesireable results. This issue has lessened as more applications support PDF 1.4.

Another consideration is that Illustrator 10.x allows you to create native files that use neither PostScript nor PDF. 
These files, which can be smaller than those that include PDF, can be read only by Illustrator 10.x.

Reason: The application cannot support the PDF 1.4, the format used for native Illustrator10.x files. 

Solution: Use InDesign 2.x, which supports the PDF 1.4 portion of native Illustrator 10.x files. You may also try 
saving Illustrator 10.x files as Illustrator 8 EPS, but this solution isn’t recommended unless you are sure that the 
original files contain no transparency.

Note: You can use the Flattening Preview palette in Illustrator 10.x to determine if a file contains transparency. 
See “Flattening controls in Illustrator 10.x” on page 26 for more details.

Reason: When then Illustrator 10.x native file was saved, Create PDF Compatible File wasn’t selected.

Solution: Open the native Illustrator 10.x file, and resave it with Create PDF Compatible File selected.

Problem 3.3.8: DCS files placed into Illustrator or InDesign don’t print as part of a transparency.

Relevant products

Illustrator 10.x

What is happening

At this time, no mechanism is available for passing preseparated data to the flattener, and each application behaves 
a little differently when it encounters a placed DCS file that interacts with transparency. (See “What is a ‘Trans-
parency Interaction’?” on page 5 for details.) The logic in Illustrator 10.x causes the DCS file to be ignored during 
flattening, so it appears underneath all other artwork in the final output. The logic in InDesign 2.x passes the low-
resolution composite representation created with the DCS file to the flattener.

Note: By visually inspecting a document, you can’t always tell if a placed EPS file interacts with transparency. In 
Illustrator 10.x, the Flattening Preview palette lets you make this determination. The plug-in for this palette and 
instructions for using it are in the Utilities/Flattening Preview folder where you installed Illustrator 10.x.

Reason: In Illustrator 10.x, a placed DCS file that interacts with transparency is rendered as if it is at the bottom of 
the drawing stack (that is, underneath everything else in the design).

Solution: If the DCS image uses only process inks, and the source file is available, reopen the source file in the 
application that created it, and resave it in a composite format that Illustrator 10.x can place-embed (for example, 
EPS or PDF). If you have the right software, you may also be able to recombine the DCS file data into a composite 
format, and then resave it in a composite format that Illustrator 10.x can place-embed.

If the DCS image uses one or more spot color channels and contains no raster data, and if the source file is available, 
reopen the source file in the application that created it, and resave it in a composite format that Illustrator 10.x can 
embed (such as EPS). 
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If the DCS image uses one or more spot color channels applied to raster data, note that Illustrator 10.x cannot 
represent spot colored raster data internally. However, in Illustrator 10.x, you can change the drawing order (for 
example, move the image up to another layer) or reposition the placed file so it is above or doesn’t interact with trans-
parency in the file. If you try this solution, you may need to work with the designer to ensure that the design isn’t 
compromised.

Note: Illustrator 7.0 and later can separate linked DCS 1.0 files and multiple-file DCS 2.0 files that don’t contain spot 
colors. Only Illustrator 8.0 and later can separate linked single-file DCS 2.0 files or multiple-file DCS 2.0 files that 
contain spot colors. Alternatively, if you can instead place the file in InDesign 2.x—which supports spot colored raster 
data—you may be able to use InDesign to work around the problem.

Reason: In InDesign 2.x, a placed DCS file that is involved in transparency is rendered using the low-resolution 
composite representation.

Solution: If the source file for the linked DCS file is available, reopen the source file in the application that created 
it, and resave it in a composite format that InDesign 2.x can place (for example, EPS or PDF). If you have the right 
software, you may also be able to recombine the DCS file data into a composite format, and then resave it in a 
composite format that InDesign 2.x can place-embed.

Problem 3.3.9: Duotones, tritones, and quadtones placed into Illustrator artwork don’t print as 
part of a transparency.

Relevant products

Illustrator 10.x

What is happening

Illustrator 10.x supports two types of placed files: linked and embedded. EPS graphics and images in placed-linked 
files that are involved in transparency (as defined on page 5) appear under all other objects when flattening a file in 
Illustrator 10.x.

Note: By visually inspecting a document, you can’t always tell if a placed EPS file interacts with transparency. 
In Illustrator 10.x, the Flattening Preview palette lets you make this determination. This plug-in for this palette 
and instructions for using it are in the Utilities/Flattening Preview folder where you installed Illustrator 10.x.

You can usually correct this problem by changing placed files from place-linked to place-embedded. However, 
Illustrator 10.x doesn’t support place-embedded links for content that can be represented only by spot colored 
rasters. If you try to place-embed such files, the spot colors convert to process equivalents.

Reason: Duotone, tritone, and quadtone files (typically EPS, although multi-tone images may also be Photoshop 
format or PDF) can be place-linked only into Illustrator artwork and be passed on to the printing device: They 
cannot be place-embedded. However, placed files that interact with transparency must be place-embedded for the 
flattener to process them correctly. When such files are place-embedded in Illustrator 10.x, the spot colors convert to 
process equivalents.

Solution: Illustrator 10.x doesn’t offer a simple solution for place-embedding duotones, tritones, and quadtones, 
which are represented using spot-colored rasters. Instead, in Illustrator 10.x, you can change the drawing order 
(for example, move the image up to another layer) or reposition the placed file so it is above or doesn’t interact with 
transparency in the file. If you try this solution, you may need to work with the designer to ensure that the design 
isn’t compromised.
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Alternatively, if you can instead place the file in InDesign 2.x—which supports spot colored raster data—you may be 
able to use InDesign to work around the problem.

Problem 3.3.10: Spot colors or overprinting don’t print from PDF 1.3 files created with Illustrator.

Relevant products

Illustrator 10.x

What is happening

Spot colors and overprinting instructions aren’t preserved in the PDF 1.3 file created by Illustrator 10.x. This is 
related to the PDF 1.3 exporting process in Illustrator, not to the flattener nor the PDF 1.3 file format.

Reason: The artwork was saved as PDF 1.3 directly from Illustrator 10.x.

Solution: Obtain the original Illustrator 10.x file, and create a PDF 1.3 file by first saving the file as an Illustrator 10 
EPS or PostScript file. Then, use Acrobat Distiller to create a PDF 1.3 file, which retains spot colors and overprinting.

Tip: Acrobat 5.x can identify which application produced a PDF file if you choose File > Document Info.

Note: Spot inks used in a gradient mesh in a native Illustrator 9.x or later file or an Illustrator PDF file, may convert 
to process if the placed graphic is involved with transparency and the publication is printed using InDesign's built-in 
separations output mode. This can be avoided by using the In-RIP separations method, or by re-saving the Illustrator 
file as an EPS. [483567]

For more information on working with overprinting, see “Problem 3.1.2: Overprinting instructions are lost.” on 
page 40.

Related InDesign Note: When exporting to PDF with "Leave Unchanged" selected as the color space option, color 
space conversion may still occur if Simulate Overprint is enabled, or if the spread contains transparency. To use these 
features, the color space will need to be converted to the document's transparency blend color space. For best results 
in these cases, ensure that the PDF Export color space matches the Transparency blend space. If you require the color 
of the TIFF file to remain unchanged, you should choose Acrobat 5 Compatibility in the PDF Export dialog. 
[452783] (reference to 3.5.x color conversion)

Problem 3.3.10: A PDF 1.3 file created using Illustrator or InDesign prints poorly. For example, 
resolution artifacts or color stitching occur.

Relevant products

Illustrator 10.x, InDesign 2.x

What is happening

The resolution settings, the amount of rasterization on the flattened file, or both create abutting areas with different 
resolutions or color spaces. 
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Reason: The Raster/Vector Balance control or the Rasterization Resolution settings that were in effect for flattening 
are inappropriate for the intended output device.

Solution: If the PDF 1.3 file was created using Illustrator 10.x, open it in Illustrator 10.x, and adjust the 
Raster/Vector Balance control to the highest fidelity (rightmost position). You may also want to increase the settings 
for Rasterization Resolution if they seem excessively low. (See “What resolution settings are correct?” on page 24 for 
details.) Save the file as Illustrator 10.x EPS, and then use Acrobat Distiller to re-create the PDF 1.3 file.

Alternatively, if you intend to place the PDF 1.3 file into an InDesign 2.x document, and you have the native 
Illustrator file from which it was made, you can use the native Illustrator 10.x file directly without flattening first.

If the PDF 1.3 file was created using InDesign 2.x, obtain the original InDesign 2.x file, select the High Quality 
flattener style, and then reexport the PDF 1.3 file. You may also need to adjust or disable any local flattener settings 
that are applied to spreads in the InDesign 2.x file. See “Flattening controls in InDesign 2.x” on page 28 for details.

Problem 3.3.11: A PDF 1.4 file fails to place, print, or separate when placed in a non-transparency 
aware application

Relevant products

InDesign 1.5, QuarkXPress, Acrobat 4.x, Adobe PageMaker 6.5

What is happening

Live transparency in the PDF 1.4 file is ignored because the receiving application doesn’t support live transparency 
(such as InDesign 1.5, QuarkXPress, Acrobat 4.x or PageMaker 6.5). Symptoms include an opaque version of the 
transparency, failure to print, or other unexpected results.

Reason: The file wasn’t saved in a flattened format that the application can display, import, print, or separate.

Solution: If the PDF 1.4 file was saved from Illustrator 10.x, reopen it in Illustrator 10.x, and save it as Illustrator 10 
EPS for placement in the other application. If you prefer to place a PDF 1.3 file, first save the PDF 1.4 file as an 
Illustrator 10 EPS or PostScript file from Illustrator 10.x, and then use Acrobat Distiller to create a PDF 1.3 file. 

If the PDF 1.4 file was saved from InDesign 2.x, reopen the native InDesign 2.x file from which it was created, and 
then export it to either PDF 1.3 or EPS.

If the receiving application is Acrobat 4.x, consider upgrading to Acrobat 5.x, which can interpret PDF 1.4 and
transparency. For similar reasons, consider upgrading to InDesign 2.x if you use InDesign 1.5 for page layout.

Note: A PDF 1.4 file created using Acrobat Distiller 5.x doesn’t contain live transparency because PostScript or 
Illustrator 10 EPS files that are passed to Distiller are already flattened. For a PDF 1.4 file to retain live transparency, 
it must be created from Illustrator 10.x or InDesign 2.x. Acrobat 5.x can open, view, and print any PDF 1.4 file. When 
the file is printed from Acrobat 5.x, the file’s transparency is flattened according to the flattener settings in Acrobat—
not those of the application used to create the file. See “Controls in Acrobat 5.x” on page 31 for details.
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Problem 3.3.12: Unable to place a native Illustrator 10.x file in InDesign.

Relevant products

Illustrator 10.x, InDesign 2.x

What is happening

Native Illustrator 10.x files typically contain both a special Illustrator-only data section and a PDF 1.4 data section. 
InDesign 2.x uses the PDF 1.4 data section to render the contents of the file when it is placed. To reduce file size, 
Illustrator 10.x provides the option of omitting the PDF 1.4 data section. Without the PDF 1.4 data section, however, 
a file cannot be placed in InDesign 2.x spreads.

Reason: An Illustrator 10.x file was saved without the PDF 1.4 data section.

Solution: Regenerate the PDF 1.4 data section by opening the native Illustrator 10.x file and selecting Create PDF 
Compatible File in the Options dialog box.

Problem 3.3.13: Transparency effects do not display correctly when viewed in Acrobat 4.0.x 

Relevant products

Acrobat 4.x, 5.x

What is happening

The Acrobat 4.0.x viewers do not support PDF 1.4 or overprint preview. As a result, most transparency effects and 
any content that uses overprinting to achieve any given effect will not display correctly in Acrobat 4.0.x. Some 
examples are: drop shadows, feathers, opacity settings, blend modes and colorized grayscale images. 

Solution: For these objects to display correctly in Acrobat 4.0, export the content from InDesign as Acrobat 4.0 
Compatible and select Simulate Overprint ON from the Advanced options. [427725]

Problem 3.3.14: A placed PDF 1.3 file has lost spot colors and text and prints poorly (resolution 
artifacts or color stitching).

Relevant products

Illustrator 10.x, Acrobat 4.x, 5.x

What is happening

The file was flattened in Illustrator 10, which doesn’t preserve spots and text. Inappropriate flattening settings might 
have been used to result in low quality output. PDF 1.3 format does not retain live transparency. 

Solution: Open the original non-flattened file, resave it to EPS with appropriate flattener settings, then distill the 
EPS to PDF 1.3

Problem::: Graphics with live transparency are placed into non-transparency aware application, which produces 
unexpected results on screen and in print. 

The non-transparency aware application ignores any live transparency when previewing/printing the file.

Solution: Open the file back in Illustrator and export in a format the non-transparency-aware app will understand 
(EPS) Must export flattened EPS file so amalgamated app can understand.
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Problem 3.3.15: Objects with transparency view differently when exported to PDF 1.3 vs. 1.4

Acrobat uses RGB to display transparency effects that have not been flattened. Consequently, any transparency effect 
exported as 4.0 Compatible, from a document whose blend space is CMYK or whose color has been converted to 
CMYK will look slightly different than the same content exported with Acrobat 5.0 selected. [426366]

Files exported from InDesign to PDF 1.3 should be viewed in Acrobat 5.0.5 with Overprint Preview enabled to 
display correctly. In order to simulate some transparency effects involving spot colors or spot colorized TIFF files 
in PDF, InDesign makes use of over-printing. By default, Acrobat 5.0.5 does not provide onscreen simulation of 
overprint, so the resulting PDF may look incorrect. Note that this is a display problem only and the PDF will separate 
correctly on printers that support overprint. Some examples of where this may occur are using spot colored objects 
involved in transparency.

Section 3.4: Performing image replacement

Common scenarios

Using manual methods

Using server-based OPI image replacement

Using RIP-based APR image replacement (part of Scitex printing systems)

The effects of flattening

Imported images may be involved in transparency. Customers may provide artwork with placeholder or sample 
images, expecting you to replace them with the high-resolution versions prepared separately. Flattening, however, 
applies only to whatever is present in the document at the time of flattening, leading to three different issues: 

• In Illustrator 10.x, the flattener doesn’t follow place-linked files, so all placed files that interact with transparency 
must be place-embedded first to ensure the proper results. See “Section 3.3: Graphics and images” on page 48.

• In Illustrator 10.x, the flattener operates on whatever data is present at the time a document is exported or printed. 
Replacing images that interact with transparency (or to which transparency effects, such as feathered edges, were 
directly applied) after flattening results in partial or total loss of the desired effect, inappropriate inclusion of low-
resolution or proxy image data in the final output, or both.

• In InDesign 2.x, the code that generates OPI comments if Omit Images is selected doesn’t process any placed 
images that interact with transparency. Therefore, these images aren’t replaced during OPI image replacement.

Image replacement usually happens automatically, using a system such as OPI or APR (part of Scitex Brisque) 
just before or as part of final output. Typically, these automatic methods occur after flattening unless they are part 
of a PDF 1.4-based workflow, since transparency isn’t flattened in that file format. Therefore, if transparency is 
involved, image replacement must take place well before final output—a rule sometimes known as “fattening 
before flattening.”
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Problem 3.4.1: Transparency effects are poor or lost after image replacement.

Relevant products

Illustrator 10.x

What is happening

In Illustrator 10.x, when placed images involved in transparency are flattened, new drawing objects are often created 
based on the existing image data. When image replacement is performed on such a file, both low-resolution and 
high-resolution image data is present, causing some effects to be lost or to appear “cut up” or “jaggy.”

Reason: The file was flattened using the low-resolution version of the image, and the image was subsequently 
replaced with a high-resolution version.

Solution: Obtain the Illustrator 10 EPS file or original Illustrator 10.x artwork and high-resolution image, manually 
place-embed the high-resolution image into the document (using the Links palette and the Embed Image 
command), and print the document from Illustrator 10.x or resave it as Illustrator 10 EPS. Problem 3.4.x: OPI 
and Simulate Overprint

The Omit for OPI options in the Advanced Print panel are ignored when Simulate Overprint is enabled in the 
Output Print panel despite the fact that you can select both Simulate Overprint and Omit for OPI. In order to enable 
the Omit for OPI, you must first disable the option Simulate Overprint in the Output Print panel. 

Problem 3.4.2: The low-resolution or proxy version of an image prints after OPI.

Relevant products

InDesign 2.x

What is happening

When an InDesign 2.x document is prepared for an “omit” OPI workflow, InDesign determines whether or not 
placed files interact with transparency. OPI comments are applied only to placed files that don’t interact with trans-
parency (See “What is a ‘Transparency Interaction’?” on page 5).

Reason: OPI comments aren’t generated for placed files that interact with transparency.

Solution: IChange the drawing order (for example, move the file up to another layer) or reposition the placed file 
so it doesn’t interact with transparency, if you can do so and maintain the integrity of the design. You may need to 
work with the designer to ensure that the design isn’t compromised. 

Another solution is to manually replace the affected placed low-resolution or proxy file with high-resolution image 
data prior to flattening.

Problem 3.4.3: OPI and Simulate Overprint

The Omit for OPI options in the Advanced Print panel are ignored when Simulate Overprint is enabled in the 
Output Print panel despite the fact that you can select both Simulate Overprint and Omit for OPI. In order to enable 
the Omit for OPI, you must first disable the option Simulate Overprint in the Output Print panel. 
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Section 3.5: Handling color conversions

Common scenarios

Dealing with color gamut

Using ICC color management

Mapping spot colors

Flattening transparency via the Flatten Transparency command

Proofing on composite devices

Outputting on high-end printing systems

The effects of flattening

The flattener causes colors to be converted in two ways that may be undesirable or unexpected:

• Color blending associated with transparency may be done in a color space that doesn’t provide a good match with 
the color gamut of the intended output device. For example, colors may convert from SWOP CMYK to Adobe 
RGB—two gamuts that generally don’t match very well. 

Color stitching may also occur if portions of a vector object are rasterized in a flattened file, because some printer 
drivers and proprietary high-end printing systems use different color management algorithms for processing vectors 
and rasterized graphics. While this problem isn’t new in print workflows, it may become more acute if transparency 
is involved.

For information on handling spot color conversions, see “Section 3.1: Printing separations” on page 38.

Problem 3.5.1: The output device cannot reproduce some colors in a flattened document.

Relevant products

Illustrator 10.x, InDesign 2.x

What is happening

The blend between transparent objects is in a color space that doesn't completely match the color gamut of the 
intended output device. In Illustrator 10.x, the color space used for blending is the same as the document working 
space. In InDesign 2.x, the color space used for blending is specifically designated for transparency associated with 
the document11. 

Note: This problem occurs only if ICC color management is enabled.

Reason: The color space used to blend transparent objects is different from that of the intended output device.

Solution: If you are flattening from Illustrator 10.x, obtain the Illustrator 10 EPS file or original Illustrator 10.x 
artwork, and then choose a CMYK working space profile for the file, making sure that the profile is better than or 
exactly matches final output conditions before flattening. Transparent objects will then be assigned suitable in-
gamut colors. To change the CMYK working space, either select a different color management settings file or change 
the CMYK working space profile in your current settings. 

11. For details about color management concepts and controls, see the on-line help for Illustrator 10.x and InDesign 2.x.
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If you are flattening from InDesign 2.x, obtain the original InDesign 2.x file, and review the transparency blending 
space by choosing File > Transparency Blending Space. For print workflows, set the blending space to Document 
CMYK to best match final output conditions.

If you already use the Document CMYK blending space, then you may also need to change the working space profile 
associated with it. This working space should match as closely as possible the color characteristics of the final output 
device. To change the CMYK working space, either select a different color management settings file or change the 
CMYK working space profile in your current settings. (See “Turning on and setting up color management” in the 
InDesign 2.x user guide).

Problem 3.5.2: The colors are unacceptable in a placed file that interacts with transparency.

Relevant products

InDesign 2.x

What is happening

The flattener creates a new color to simulate the blend between transparent objects, some of which are in a placed 
file. However, because the color space (or spaces) of the objects in the placed file and the InDesign 2.x document 
don’t match, the transparency blending space is used to create this new color. (InDesign 2.x doesn’t provide a 
warning when this problem occurs.) 

Note: This problem occurs only if you ICC color management is enabled.

Reason: A significant colorimetric difference occurs between the color working space (or spaces) of a placed file and 
the transparency blending space. The result is an unacceptable shift in the color of objects in the placed file.

Solution: Review the transparency blending space of the file by choosing File > Transparency Blending Space. For 
print workflows, set the blending space to Document CMYK to best match final output conditions. 

If you already use the Document CMYK blending space, then you may also need to change the working space profile 
associated with it. This working space should match as closely as possible the color characteristics of the final output 
device.To change the CMYK working space, either select a different color management settings file or change the 
CMYK working space profile in your current settings. (See “Turning on and setting up color management” in the 
InDesign 2.x user guide).

If the current transparency blending space is already well matched with the intended final output conditions, then 
you may need to consider using placed content that is better prepared to match these conditions. Check with the 
designer and consider modifying the color working space (or spaces) in the placed file itself.

Problem 3.5.3: Colors are jaggy and irregular (that is, color stitching occurs) in a flattened file.

What is happening

Flattening results in subdividing objects into small pieces that share boundaries. Those small adjacent pieces are 
separate objects often with different types of fills (solid, gradients, images, etc.) necessary to represent the color of 
the inteserctions of objects. Different types of fills are likely to be processed differently by output devices, which 
would result in a problem called color stitching. The color areas appear jagged and may include unexpected color 
transitions between raster and vector objects. 
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For example, some devices have special color enhancements applied by default to raster fills with the intent to 
improve the quality of photos. As a result, a vector object that gets partially rasterized may undergo color transfor-
mations that create stitching artifacts where rasterized and unrasterized data abut.

If a vector object is placed over a raster background, the results (right) 
can include blocky color stitching artifacts.

Reason: The Raster/Vector Balance setting may be too low or the Clip Complex Regions option may need to 
be enabled.

Solution: In Illustrator 10.x, set the Raster/Vector Balance control to the highest fidelity (rightmost position) 
or select Clip Complex Regions (if the setting for Raster/Vector Balance is lower than the rightmost position), 
and then resave the file. To preview the results immediately in Illustrator 10.x, use the Flattening Preview palette. 
See “Flattening controls in Illustrator 10.x” on page 26 for details. 

Note: The new settings may cause the flattener to take longer and use more memory. InDesign 2.x uses special flattener 
styles to record and reuse flattener settings more easily. The High Resolution style provides the best results for most 
output devices. You should also review any local flattener settings that were applied to spreads in the InDesign 2.x file. 
You may need to adjust or disable these settings, as appropriate. See “Flattening controls in InDesign 2.x” on page 28.

Reason: The printing device makes special optimizations for color depending on the type of object—for example, 
image data is handled differently than vector data—or the printer has a particular color rendering dictionary enabled 
that causes unexpected color output for vector and raster data. It is common for composite printers to allow for 
“intelligent” or “vivid” color treatment of images.

Solution: If possible, disable these printer optimizations before printing. For desktop devices, you can usually 
disable this optimization through a device-specific panel in an application’s Print Setup dialog box. For a high-end 
printing system, review the system’s documentation to determine your options.

When printing transparent objects from InDesign, Acrobat or Illustrator to a desktop color printer, make sure that 
advanced color controls are disabled at the printer. The flattener may need to rasterize some transparent objects to 
represent them correctly. Some desktop printers offer “enhancements” that render images differently than vector 
objects. This can sometimes lead to visual differences between objects that appear the same in the original document. 

If this solution doesn’t work, you can try to eliminate or minimize rasterization in the flattened or printed file. See 
the previous solution for details.
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Problem 3.5.4: Remapping spot inks is impossible or gives unexpected results after flattening 
a file.

Relevant products

Illustrator 10.x, InDesign 2.x

What is happening

Spots may get converted to process in certain export formats (such as PDF 1.3 from Illustrator) or because certain 
raster-effects are used, but not because of flattening itself. Remapping spot colors in such flattened files may be 
impossible (if all the spot colors converted to process) or may produce unexpected results. The latter is especially 
noticeable if you try to make a radical change in a spot color, such as remap Pantone 116 C (a yellow ink) to Pantone 
569 C (a greenish-blue ink).

Reason: A file containing spot colors and transparency was exported as EPS using Illustrator 10.x, causing some or 
all spot colors to convert to process colors.

Solution: If you use InDesign 2.x for page layout, you may be able to resolve the problem by using the unflattened 
native Illustrator 10.x file. InDesign 2.x preserves spot inks during flattening, and you can then remap them with the 
InDesign 2.x ink manager.

Another option is to remap the desired spot colors before you flatten the file in Illustrator 10.x, if you have either the 
existing Illustrator 10 EPS or the native Illustrator 10.x file.

Problem 3.5.5: All spot colors convert to process colors after flattening objects via the Flatten 
Transparency command in an Illustrator file.

Relevant products

Illustrator 10.x

What is happening

Illustrator 10.x lets you select one or more objects in a design, and then manually flatten them using the Object > 
Flatten Transparency command. This feature can be used to work around certain other transparency-related 
problems. However, it doesn’t always provide the same results as flattening on export or printing, so it must be 
used carefully.

Reason: Spot colors always converted to process colors after flattening via the Flatten Transparency command, even 
if the spot colored objects don’t interact with transparency

Solution: Defer flattening until the file is exported or printed, as these methods work to preserve spot colors 
wherever possible.
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Problem 3.5.6: The wrong spot colors appear in an InDesign document after flattening.

Relevant products

InDesign 2.0

What is happening

This problem occurs if you flatten multiple InDesign 2.0 documents that use spot colors and transparency. After 
you process one document that mixes spot colors and transparency, the logic that manages inks in InDesign 2.0 
doesn’t correctly reinitialize itself. If you then open and flatten a second document that also mixes spot colors and 
transparency, the spot colors from the first document are used.

Reason: This problem is a bug in InDesign 2.0.

Solution: Install the InDesign 2.01 update, which you can download from Adobe’s Web site.

Section 3.6: Trapping

Problem 3.6.1: Flattened files are trapped incorrectly. 

Relevant products

InDesign 2.x, PostScript in-RIP trapping engine

What is happening

Most trapping engines use different sets of rules for processing vector and image data. In fact, trapping is commonly 
disabled for image data entirely. Because flattening can cause vector and type objects to become rasterized, the traps 
generated for such files can be incorrect or incomplete.

: The trapper isn’t configured to process internal raster data, so trapping is incomplete.

Solution: Make sure that Raster/Vector Balance is set to the highest fidelity (rightmost position) before flattening. 
Often, this change can completely eliminate rasterization and solve all resulting trapping problems.

Another solution is to enable the internal image trapping option, which traps the image data internally. This option 
isn’t available when trapping from InDesign 2.x. Also, setting internal image trapping for the whole page causes all 
image data to be trapped internally, including natural image data that can cause other problems.

Reason: The trapper’s rules for processing internal raster data don’t match those use for vector data.

Solution: Set the image trap placement rules to Normal, so that image trapping uses the same rules as vector 
artwork. (The same result happens automatically when internal image trapping is first enabled.) Since this setting 
applies to all image data, including both natural image data and rasterized vector data, other trapping-related 
problems may still occur.

Reason: The trapper doesn’t trap images to other images unless explicitly configured to do so.

Solution: While the trapping rules to generate image to image traps exist, this approach isn’t recommended for 
flattened files that contain rasterized regions. 
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Problem 3.6.2: Opaque objects touching objects with transparency effect trapping

Relevant products

InDesign 2.x

What is happening

Opaque objects that are touching objects with transparency are being affected or flattened.

Objects that do not have transparency applied to them can be affected by those adjacent transparent objects. This 
especially relates to overprinting objects or spot colors that sit on top of other objects that may have transparency 
applied to them. 

Solution: Be sure that any opaque objects that are in a stack of objects with transparency are on the top of the 
stack of objects, or in the topmost stack of layers. This will keep the topmost objects from being included in the 
transparency flattening. Also, turn on Overprint Preview (under the View Menu) in order to see the actual mixing 
of the colors.

Section 3.7: Flattening

Problem 3.7.1: Strokes thicken after flattening

Relevant products

InDesign 2.x, Illustrator 9.x, 10.x

What is happening

Stroke weights may appear to be thicker for content that has been flattened (exported to PDF 1.3 or printed) due to 
the fact that the strokes have been converted to fills. On a high-resolution device this should not present a problem. 

Solution: Select Convert Strokes to Outlines to make the strokes consistent.

Problem 3.7.2: Artifacts appear on screen after flattening

Relevant products

InDesign 2.x, Illustrator 9.x, 10.x

What is happening

Artifacts appear onscreen when flattening overlapping transparent objects that have been exported to PDF

Reason: When overlapping objects have transparency applied to them, which is flattened upon print or conversion 
to PDF, there is the possibility of artifacts appearing onscreen - tiny dots of misplaced color or white on the edges 
of objects that were flattened. Many times these artifacts only appear onscreen, and do not appear in the final high-
resolution print output. 

Solution: If artifacts do appear in print, increase the flattener resolution.
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Problem 3.7.3: The output device cannot reproduce some colors in the flattened document 
because inappropriate color space was used when flattening.

Relevant products

InDesign 2.x

What is happening

Flattening results in merging objects into a single layer. The final merged color must be in the output color space. 

Solution: Flattening must be done in the color space of the output device. Open the unflattened file and re-save
(re-flatten) using the correct color space of the output device.

Section 3.8: RIP specific issues and solutions
General recommendations

• Upgrade/update to the latest RIP version 

• Test/Proof common files through any new software or RIP versions

Agfa information:

Latest RIP versions:

• Apogee Viper 3.04 and Apogee PDF RIP (From Apogee PDF RIP for Macintosh 1.0.1 Read Me First; Revision 1, 
October 25th, 2001 and also Apogee PDF RIP for Windows 2.0 Read Me First; Revision 2; September 14th, 2001)

3.8.1: PDF 1.4 and Apogee PDF RIP

PDF 1.4 files that contain transparent objects will not output correctly when processed directly by Apogee PDF RIP 
(i.e. when PDFs are dropped in the Hot Folder). As a workaround, in the creating application, save the file as a PDF 
1.3 file or as an EPS file. Alternatively, open these PDF files in Acrobat 5 or later and print them to the RIP from 
Acrobat. This will automatically "flatten" the transparent objects since transparency is not supported in PostScript 
or in PDF 1.3.

Creo information:

Latest RIP versions:
Brisque version 4.0.79 (transparency will be ignored and objects with transparency will be made opaque)
Creo Prinergy 2.0.7 and later RIPs will flatten PDF 1.4 files that contain transparency
Creo PS/M 7.1 and later RIPs will flatten PDF 1.4 files that contain transparency

3.8.2: Creo/Scitex Brisque 3.0, 4.0 setting for processing files with transparency

Most CreoScitex RIPs have a PostScript Overprint setting, which is by default, turned off. This must be turned on in 
order to properly separate PostScript files that were generated from InDesign 2.0 files that include transparency. 
Overprinting is a fundamental component of flattening transparency and converting to PostScript. If this PostScript 
Overprint setting is turned OFF, the transparency information will not show through the CT layers properly, and 
areas may appear without the proper overprinting of objects that had transparency applied to them. 
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3.8.3: Creo Brisque 3.0 and 4.0, user must flatten PDF 1.4 files prior to RIPing

Problem:: Abnormal termination on the Brisque can occur when processing files with a spot drop shadow or 
clipping path that touches text in registration color and printed Composite or to In-RIP separations. 

Workaround: Move the registration text to the front, above the drop shadow and move the spot drop shadow away 
from the text, so it doesn’t touch.

3.8.4: Creo Prinergy 2.0 and earlier and spot colors

: Prinergy 2.0 and earlier may convert spot colors to process colors if the spot color has transparency applied, is used 
in a duotone, or is used as a spot-to-process gradient. 

Solution: These issues can be resolved by upgrading to Prinergy v.2.0.2 or later

3.8.5: Creo PS/M 7.0

User must flatten PDF 1.4 files prior to RIPping

Use Creo PDF2PS v2.0b2* (with support for PDF 1.4) to convert back to PostScript 3

Harlequin information: 

3.8.6: Harlequin RIP v 5.3 r4 handles AI 10 with transparency

Problem:: PDF files exported from InDesign and then printed from Acrobat 5.0.5 to a Harlequin ScriptWorks RIP 
5.5 r0 will produce a PostScript error. 

Solution: A fix was made by Harlequin and is available as a patch in the ScriptWorks RIP 5.5 r1. Also use the latest 
print drivers available.

Heidelberg information:

Latest RIP versions:
Heidelberg Prinergy V 2.0.7.13
Heidelberg Delta RIP
Heidelberg MetaDimensions 2.6

3.8.7: Heidelberg MetaDimension overprint not retained (supports PostScript Level 1,2,3 / 
PDF 1.3) 

Problem:: Overprint settings on process colors will not be retained when processing composite PostScript files 
(this includes selecting PostScript File from the print dialog) to the Panther or Heidelberg MetaDimensions RIP. 

Solutions: To retain overprint settings, print as either host-based separations or In-RIP separations. Upgrade to 
MetaDimensions 2.5 or higher

3.8.8: Heidelberg Prinergy 2.0 and earlier and spot colors

Problem: May convert spot colors to process colors if the spot color has transparency

duotone, or is used as a spot-to-process gradient.

Solution: These issues can be resolved by upgrading to Prinergy v.2.0.7.
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3.8.9: Rampage information

Latest RIP version is 8.4b43 - earlier versions will not handle flattened transparency or native InDesign files.
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The following two tables cover the capabilities of standard input and output file formats used in Adobe applications 

as they relate to transparency, spot colors, overprint, and color separations.

Table1: Input File Formats and Transparency Compatibility by Application

Application Input Formats (place 
or open)

Transparency Capabil-
ity

Spot Colors Overprint 
Preserved

Suitable for Color 
Separations

InDesign 2.x Illustrator Native Live or 

preflattened

Yes Yes Yes

Photoshop Native Live (as alpha channel) No N/A Yes

PDF 1.4 Live or 

preflattened

Yes Yes Yes

PDF 1.3 Flattened Yes Yes Yes

EPS (from AI, PSD) Flattened** Yes Yes Yes

Other formats? GIF? 
(TIFF, JPEG, etc.)

Flattened* Yes N/A Yes

Illustrator 10.x Native

Illustrator

Live or preflattened Yes Yes Yes

Native

Photoshop

Live (as alpha channel) No N/A Yes

PDF 1.4 Live or 

preflattened divide?

Yes Yes Yes

PDF 1.3 Flattened No Yes Yes

EPS (from Illustrator 
and Photoshop

Flattened** Yes Yes Yes

Other formats? (TIFF, 
JPEG, etc.)

Flattened* No N/A Yes

Acrobat 5.x PDf 1.4 Live or 

preflattened

Yes Yes Yes

PDF 1.3 Flattened Yes Yes Yes

EPS or PostScript 

Interpretation

Flattened Yes Yes Yes

PageMaker, 
QuarkXPress and 
other non-trans-
parency aware 
apps

All accepted place and 
open formats (EPS, 
TIFF, PDF 1.3, JPEG, 
etc.)

Flattened--no compatib-
lity with transparency
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Table 2: Output File Formats and Transparency Compatibility by Application

Application Output Formats Transparency 
Capability

Spot Colors Overprint 
Preserved

Suitable for Color 
Separations

InDesign 2.x Natiive

InDesign 

Live. Yes Yes Yes

PostScript (for RIP or 
Distiller)

Flattened Yes Yes Yes

PDF 1.4 Live Yes Yes Yes

PDF 1.3 Flattened Yes Yes Yes

EPS Flattened Yes Yes Yes

Illustrator 10.x Native

Illustrator 10.x

Live or preflattened Yes Yes Yes

Native

Illustrator 8.x

Flattened No Yes*** Yes

PostScript (for RIP or 
Acrobat Distiller)

Flattened Yes Yes Yes

PDF 1.4 Live or Flattened Yes Yes*** Yes

PDF 1.3 Flattened No No Yes

EPS Flattened** Yes Yes*** Yes

Other formats Flattened* No No No

Acrobat 5.x PDF 1.4 Live or

Flattened

Yes Yes Yes

PDF 1.3 Flattened Yes Yes Yes

Other formats (EPS, 
JPEG PostScript, etc.)

Flattened* Yes Yes Yes

PageMaker, 
QuarkXPress and 
other non-trans-
parency aware 
apps

All output formats 
(EPS, TIFF, PostScript, 
JPEG, etc.)

Flattened

* Note that some of these formats (GIF, JPEG, etc.) can handle transparency in the graphical sense but they can’t handle live transpar-
ency.

** Illustrator can open AI EPS files, and the transparency can be edited. All other products can place and use the flattened portion of 
the EPS file. The file may need to be place-embedded.

*** Turn on Preserve Overprints When Possible checkbox (in Document Setup>Transparency).
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